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PHOTO/TV CHECKLIST 
STS-128 FLIGHT SUPPLEMENT 
LIST OF EFFECTIVE PAGES 

 
FINAL 05/15/09
PCN-1 06/22/09
PCN-2 07/31/09
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FS iii ................................ * 128/FIN 2 
FS iv ................................ * 128/FIN 2 
FS v ................................. * 128/FIN 2 
FS vi ................................ * 128/FIN 2 
FS vii ............................... * 128/FIN 2 
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FS ix ................................  128/FIN 2 
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FS 1-50 ............................  128/FIN 2 
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FS 1-51 ............................  128/FIN 
FS 1-52 ............................ ⊗ 128/FIN 2 
FS 1-53 ............................  128/FIN 
FS 1-54 ............................  128/FIN 
FS 1-55 ............................  128/FIN 
FS 1-56 ............................  128/FIN 
FS 1-57 ............................  128/FIN 
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FS 1-61 ............................  128/FIN 
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FS 1-64 ............................  128/FIN 
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FS 1-66 ............................  128/FIN 
FS 1-67 ............................  128/FIN 
FS 1-68 ............................  128/FIN 
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10-21 ............................... † generic 
10-22 ............................... † generic 
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12-9 ................................. † generic 
12-10 ............................... † generic 
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12-20 ............................... † generic 
13-1 ................................. † generic 
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13-9 ................................. † generic 
13-10 ............................... † generic 
13-11 ............................... † generic 
13-12 ............................... † generic 
14-1 ................................. † generic 
14-2 ................................. † generic 
14-3 ................................. † generic 
14-4 ................................. † generic 
15-1 ................................. † generic 
15-2 ................................. † generic 
15-3 ................................. † generic 
15-4 ................................. † generic 
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15-6 ................................. † generic 
15-7 ................................. † generic 
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15-16 ............................... † generic 
16-1 ................................. † generic 
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19-2 ................................. † generic 
19-3 ................................. † generic 
19-4 ................................. † generic 
19-5 ................................. † generic 
19-6 ................................. † generic 
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20-9 ................................. † generic 
20-10 ............................... † generic 
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20-16 ............................... † generic 
20-17 ............................... † generic 
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20-19 ............................... † generic 
20-20 ............................... † generic 
20-21 ............................... † generic 
20-22 ............................... † generic 
21-1 ................................. † generic 
21-2 ................................. † generic 
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PHOTO/TV CUE CARDS 

 Title Ref. Page Card No. 
TV 

(Front) ...................................................................... FS CC 3-3 P/TV-1a/128/O/B 
(Back) ...................................................................... FS CC 3-4 P/TV-1b/128/O/C 

 
ANALOG PLAYBACK 

(Front) ...................................................................... FS CC 3-5 P/TV-2a/128/O/A 
(Back) ...................................................................... FS CC 3-6 P/TV-2b/128/O/A 

 
ET PHOTO 

(Front) ...................................................................... FS CC 3-7 P/TV-3a/128/O/B 
(Back)  ..................................................................... FS CC 3-7 P/TV-3b/128/O/A 

 
WVS 

(Front) ...................................................................... FS CC 3-8 P/TV-5a/128/O/B 
(Back) ...................................................................... FS CC 3-9 P/TV-5b/128/O/A 

 
PLBD VTR RECORDING 

(Front) ...................................................................... FS CC 3-10 P/TV-6a/128/O/A 
(Back) ...................................................................... FS CC 3-11 P/TV-6b/128/O/A 

 
LDRI/ITVC 

(Front) ...................................................................... FS CC 3-12 P/TV-7a/128/O/B 
(Back) ...................................................................... FS CC 3-13 P/TV-7b/128/O/A 

 
LCS 

(Front) ...................................................................... FS CC 3-14 P/TV-8a/128/O/A 
(Back) ...................................................................... FS CC 3-15 P/TV-8b/128/O/A 

 
IDC 

(Front) ...................................................................... FS CC 3-16 P/TV-9a/128/O/B 
(Back) ...................................................................... FS CC 3-17 P/TV-9b/128/O/A 

 
VIDEO SETUP 

(Front) .......................................................................... FS CC 3-18 P/TV-10a/128/O/D 
(Back) ........................................................................... FS CC 3-19 P/TV-10b/128/O/A 

 
D2Xs SETUP 

(Front) .......................................................................... FS CC 3-20 P/TV-11a/128/O/A 
(Back) ........................................................................... FS CC 3-21 P/TV-11b/128/O/A 

 
LDRI/ITVC A7 PLACARD 

(Front) .......................................................................... FS CC 3-22 P/TV-12a/128/O/A 
(Back) ........................................................................... FS CC 3-22 P/TV-12b/128/O/A 

 
DIGITAL PLAYBACK 

(Front) ...................................................................... FS CC 3-23 P/TV-13a/128/O/C 
(Back) ...................................................................... FS CC 3-24 P/TV-13b/128/O/A 
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P/TV01   VIDEO SETUP 

H/W SUMMARY 
WLES A31p

MON 1
Repeater Cable

A31p Video
Adapter

WLES A31p

SSV BNC to
BNC Cable

SSV to PDIP/CIP Cable

Bal/Unbal

Video

Video A (PAYLOAD)

SSV DC Pwr Cable

Pwr

PAYLOAD DATAINTERFACE PANEL 2 (L11)

CABIN P/L
J105 J107J101 J103DC1 DC2

(Not
Used)

Video Spare 1
(Gnd cntl)

SSV Compression Encoder BoxSSVTCS

Digital CC Vid/Pwr Cable (15 ft)

Wide
Conversion

Lens

VideoPwr

J2
VIDEO
J4

J6
MD

AVIU

J1
75
J5

LO
J3
J7

FD
AVIU

J2
VIDEO
J4

J6

J1
75
J5

LO
J3
J7

VideoAVIU-CC Video Cable

Digital CC Vid/Pwr
Cable (15 ft)

(Not
Used)

WVS
1

V10
J2
VIDEO
J4

J6

J1
75
J5

LO
J3
J7

WVS 1
AVIU

AVIU-CC Video Cable

Digital CC Vid/Pwr
Cable (15 ft)

(Not
Used)

Video

WVS
2

V10
J2
VIDEO
J4

J6

J1
75
J5

LO
J3
J7

WVS 2
AVIU

R
L
V

Digital CC Vid/Pwr
Cable (15 ft)

AVIU-CC Video Cable

(Not
Used)

Video

MON
1

V10
MON 1
AVIU

J1
75
J5

LO
J3
J7

J2
VIDEO
J4

J6

R
L
V

DTV Audio Cable

DTV MON 2 Cable

To
MON 2

C INP/L 3

jsc48038_128_001r3.cvx

SEC
C/L

LDRI/
ITVC

VIDEO PROCESSING UNIT

3

ON

OFFCB1

RSC VIDEO

J101 J103 J105 J107

OPP

R12

RSC Video Cable

WVS 1 TV Pwr Cable (20 ft)

WVS 2 TV Pwr Cable (20 ft)
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 FS 1-5 P/TV/128/FIN 

 P/TV01   VIDEO SETUP (Continued) 

SETUP 

NOTE 
Steps 1-7 minimum rqmt for OBSS RCC Inspection (focused and post undocked) 

 
 1. Perform ACTIVATION,OPERATION (Cue Card, TV) as reqd 

 
 2. Perform DTV Setup 

 
O19 TV PWR – OFF 

 
L10:A1 Unstow AVIU and disconnect following cables: 

ASC/ENT/FD TV Pwr Cable from J2 
AVIU Adapter Cable from J5 
ASC/ENT FD V10 Cable from J1 

A15 Connect DTV Audio Cable to PS CCU 
Config DTV H/W per H/W SUMMARY, FS 1-4 

 
Config Panels 

L10 (MUX) √VTR/CC PWR – on (LED on) 
If dnlk: 

MUX/VTR/CC PWR – on (LED on) 
√MUX BYPASS – ACT 

 
L10 (VIP) √ATU – REC 

√CCTV VIDEO IN – J3 
√PWR – on (LED on) 

 
L10 (VTR) √ON/STANDBY LED – green 

√Switches set to White Dot (seven) 
√COUNTER SELECT – COUNTER (TC) 

 
Config Video 

MON 2 SOURCE – C 
L9 Config PS ATU per Comm Plan 
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P/TV01   VIDEO SETUP (Continued) 

SETUP (Continued) 

 3. Perform MON 1,2 V10 Setup 
 

MA9F Remove MON 1,2 Desk Assy Hardware from Stow-n-Go CTB 
 

O19 TV PWR – OFF 
 

Config MON 1,2 V10s and Cables per H/W SUMMARY, FS 1-4 
Retrieve MON 1 V10 from MS1 Saddlebag 
Connect: 

MON 1,2 Digital CC Vid/Pwr Cables to MON 1,2 V10s 
MON 1,2 AVIU-CC Video Cables to MON 1,2 V10s 
Multiuse Brkt to desk 
RWS #1 Drag-Thru Cable to MON 1 AVIU J6 
MON 1 AVIU Cable to MON 1 AVIU J4 
MON 2 Balanced Video Cable to MON 2 AVIU J4 
MON 1,2 TV PWR Cable to MON 1,2 AVIU J2 
MON 1 Repeater Cable string to A31p Vid In port 
Multiuse Brkt to wall 

 
AVIU (MON 1,2) √SYNC/VIDEO – VIDEO 

√HI-Z/75 – 75 
√PWR SELECT – LO 

 
R12 (VPU) VPU PWR – ON (LED on) 

 
O19 TV PWR – ON 
V10 (MON 1,2) PWR – ON 

DISPLAY pb – toggle to display tape counter 
√Tape installed 

 
 4. √RSC Video Cable connected between R12/OPP-RSC Video (J105) and R12/WIB-CCTV PL3 
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 FS 1-7 P/TV/128/FIN 

P/TV01   VIDEO SETUP (Continued) 

SETUP (Continued) 

 5. Perform Analog Camcorder Setup for FD per H/W SUMMARY, FS 1-4, as reqd 
 

O19 TV PWR – OFF 
 

AVIU SYNC/VIDEO – VIDEO 
HI-Z/75 – 75 
PWR SELECT – LO 

 
O19,MO58F TV PWR – ON 

 
CC Install Wide Conversion lens 

√ND FILTER – OFF 
√OUTPUT – CAM 
√  
√STANDBY/LOCK – STANDBY 
PWR dial – “green”  
√Tape installed 
√Viewfinder (LCD) displays “green”  •|| 
Install Audio Muting Plug (optional) 
Install Multiuse Brkt 

 
 6. Perform LCS Cable Connections per H/W SUMMARY, FS 1-4, as reqd 

 
 Unstow MD AVIU from L10:A1 Locker 

 
Middeck Connect MD TV Pwr Cable to MD AVIU J2 
AVIU (MD) Connect end of LCS Video Cable to MD AVIU J1 

√HI-Z/75 – 75 
Flt Deck Connect other end of LCS Video Cable (A31p Video Adapter) to A31p Video Out port via PGSC Usage Chart 

Connect OPP-LCC Cable to A31p RJ45 Ethernet port via PGSC Usage Chart 
 

P/TV/128/FIN 1 



 FS 1-8 P/TV/128/FIN 

P/TV01   VIDEO SETUP (Continued) 

SETUP (Continued) 

 7. Perform SSV Setup 
 

MA16N Unstow: 
SSV Compression Encoder Box 
SSV BNC-BNC Cable 
SSV to PDIP/CIP Cable 
SSV DC Pwr Cable 
Bal/Unbal Xfmr 

 
Config SSV H/W per H/W SUMMARY, FS 1-4 

 
NOTE 

Video Spare 1 controlled by MCC instead of pnl A7 
 

L12 (SSP 2) √PDIP 2 PWR 1 (CB3) – cl 
L11 (PDIP 2) DC PWR 1 – ON 

 
Config SSV settings 

SSV IN SEL – NTSC 
Mode – 3 
OUTRATE – 4 
SSV Pwr – on 
√Pwr LED illum 
√ENC DATA LED flickering 
√FRM DATA LED flickering 
√FILL FRM pulsing 

 
Inform MCC when SSV SETUP complete 
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P/TV01   VIDEO SETUP (Continued) 

SETUP (Continued) 

 8. Perform WVS Setup 

 a. Activate WVS System 
 

A7  WIRELESS VID HTR – ON 
WIRELESS VID PWR – ON 

 
MO58F  TV PWR – OFF 

 
MA9F b. Remove WVS Hardware from Stow-n-Go CTB 

 
Config WVS 1,2 V10s and Cables per H/W SUMMARY, FS 1-4 
Connect: 

WVS 1,2 Digital CC Vid/Pwr Cables to WVS 1,2 V10s 
WVS 1,2 AVIU-CC Vid Cables to WVS 1,2 V10s 
Multiuse Brkt to desk 
Pre-routed WVS 1,2 Balanced Video Cables from R12/VPU XCVR 1,2 BAL to WVS 1,2 AVIU J4 
Pre-routed WVS TV Pwr Cables to WVS 1,2 AVIU J2 
Balanced Video Cables stowed on WVS Stow-n-Go desk to WVS 1,2 AVIU J6 
ATU Recorder Cables to left (white) port per H/W SUMMARY, FS 1-4 
Multiuse Brkt to wall 
PCMCIA-to-WIB Remote Cable to R12/WIB J701 
RS-422 PCMCIA Card/Cable Assy and PCMCIA-to-WIB Remote Cable to bottom PCMCIA slot on A31p per  
PGSC Usage Chart 

 
AVIU (WVS 1,2) √SYNC/VIDEO – VIDEO 

√HI-Z/75 – 75 
√PWR SELECT – LO 

 
V10 (two) 

MO58F TV PWR – ON 
V10 (WVS 1,2) PWR – ON 

√Tape installed 
√WVS Test Pattern displayed (color bars w/“No WVS Video”) 

PWR – OFF 
 

R10 Config MS ATU/CCU per Comm Plan 
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P/TV01   VIDEO SETUP (Continued) 

SETUP (Continued) 

 8. Perform WVS Setup (Continued) 
 

 c. WVS PGSC Prep 
 

PGSC Pwrup and Application Opening 
PGSC √Pwr – ON 

Sel Shuttle Apps icon 
Sel WVS icon 

 
Sel ‘No’ at ‘Restore To Previous Settings:’ window 

 
If ‘Comm Port Configuration’ error displayed: 

Remove Quatech RS-422 Card 
Sel ‘Start’> ‘Shut Down’> ‘Shut Down’> ‘OK’ 
Reinstall Quatech RS-422 Card in bottom PCMCIA slot 
Pwr – ON 
Sel Shuttle Apps icon 
Sel WVS icon 

RF Camera page will appear 
 

Application Setup 
If ‘Static XCVR’(‘Bad Camera ID’,‘Temp Alert’,‘Temp Caution’) alert msg: 

Perform ALERT MSG TROUBLESHOOTING (Cue Card, WVS) 
If ‘Static RF Camera’ alert msg: 

Disregard 
Sel ‘File’ → ‘Assign Camera ID’ 
Verify following: 

 
Camr Address S/N In Use Label 

16 1010 1 EV1 
18 1007 1 EV2 

 
If Camr IDs not correct: 

Sel ‘Delete Entry’ until all deleted 
Perform CAMR ID ASSIGNMENT (Cue Card, WVS) as reqd 

When complete, sel ‘OK’ 
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P/TV01   VIDEO SETUP (Concluded) 

SETUP (Concluded) 

 8. Perform WVS Setup (Concluded) 
 

 c. WVS PGSC Prep (Concluded) 
 

Application Setup (Concluded) 
 

Sel ‘File’ → ‘Advanced Controls’ 
On XVCR tab: 
√IF – selected 
√Other options not selected 

Sel RF Camera tab: 
√Power Selections – selected 
√Automatic Gain Control – selected 
√S-Band Level – selected 
√Other options not selected 

When complete, sel ‘OK’ 
 

 d. PWRDN 
 

Sel ‘File’ → ‘Exit’ 
A7 WIRELESS VID PWR – OFF 

WIRELESS VID HTR – OFF 
 

MA16N 9. Unstow,set up BPSMU w/BPSMU to CCU Adapter Cable at CDR CCU 
Connect BPSMU Batt 
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P/TV02   DOCK 

H/W SUMMARY 
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 FS 1-15 P/TV/128/FIN 

P/TV02   DOCK (Continued) 

SCENE SYNOPSIS 
Scene contains procedures for obtaining video,still photos of ISS rndz,docking 

 
SETUP 
 1. Perform ACTIVATION,OPERATION (Cue Card, TV) as reqd  
 2. Perform D2Xs PROGRAM w/FLASH for in-cabin imagery  

Lens – 12-24mm 
Aperture – Min, locked 
Body Focus Mode – S 
√Batt installed 
√Flash Card installed 
Pwr – ON 
Top LCD: 
√Batt 
√Frames remaining sufficient 

Exp Comp (       ) – 0.0 
Exp Mode – P 
Meter – Matrix (     ) 
Diopter – Adjust 
Frame Rate – S 
√BKT disabled – 0 F 
Rear LCD: 
√ISO – 100 
√QUAL – RAW 
√WB – 0,A 

AF Area Mode – [ [  ] ] 
√Focus Area – Center 
√Focus Selector Lock – L  
SB-800 Flash Settings: 

ON/OFF pb – ON 
√Diffuser Dome installed 
√MODE –  TTL BL  
√Exp Comp – 0 EV 

Tilt – 45° (Direct)  
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P/TV02   DOCK (Continued) 

SETUP (Continued) 

 3. Perform D2Xs MANUAL for docking/external imagery 
 

Remove ovhd window shields 
Lens – 400mm(80-200mm) 
If 400mm: 

Focus Limit – ∞ -6m 
Lens Focus Mode – A 

If 80-200mm: 
Focus Limit – full 
Lens Focus Mode – M/A 

Aperture – Min, locked 
Body Focus Mode – S 
√Batt installed 
√Flash Card installed 
Pwr – ON 
Top LCD: 
√Batt 
√Frames remaining sufficient 

Exp Comp (       ) – 0.0 
Exp Mode – M: 

SS – 500 
f/stop – 8 

Meter – Matrix (    ) 
Diopter – Adjust 
Frame Rate – S 
√BKT disabled – 0 F 
Rear LCD: 
√ISO – 100 
√QUAL – RAW 
√WB – 0,A 

AF Area Mode – [ [  ] ] 
√Focus Area – Center 
√Focus Selector Lock – L 

 
SB-800 Flash Settings: 

ON/OFF pb – OFF 

P/TV/128/FIN 2 
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P/TV02   DOCK (Continued) 

SETUP (Continued) 

 4. Perform Hardware Verification for V10s, FD CC, DTV 
 

O19,MO58F √TV PWR – ON 
 

R12 (VPU) √VPU PWR – ON (LED on) 
√Green Jumper – SEC C/L 
√SEC C/L Cap installed 

 
V10 PWR – ON 
(MON 1,2) 

√Tape installed 
DISPLAY pb – Toggle to display tape counter 

 
For in-cabin views: 

CC √Wide Conversion lens installed 
√ND FILTER – OFF 
√OUTPUT – CAM 
√  
√STANDBY/LOCK – STANDBY 

PWR dial – “green”  
√Tape installed 

Open LCD: 
√“green”  •|| displayed 
Install Audio Muting Plug (optional) 
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P/TV02   DOCK (Continued) 

SETUP (Concluded) 

 4. Perform Hardware Verification for V10s, FD CC, DTV (Concluded) 
 

For sunlit ISS views: 
Remove Wide Conversion Lens 
Install fresh Batt as reqd 

√ND FILTER – OFF 
AF/M – M 
AGC – OFF 
GAIN – L 

√OUTPUT – CAM 
√AWB – ON 
√ 
√STANDBY/LOCK – STANDBY 

PWR dial – M  
√Tape installed 

Open LCD: 
√“green”  •|| displayed 
SS – 1/500 
√GAIN – 0dB 
f/stop – F8.0 
√FOCUS – M ∞- (adjust as reqd) 
Install Audio Muting Plug (optional) 

 
MON 2 SOURCE – C 
L10 (MUX) VTR/CC PWR – on (LED on) 

If dnlk, MUX/VTR/CC PWR – on (LED on) 
L10 (VIP) PWR – on (LED on) 
L10 (VTR) ON/STANDBY LED – green 

√Tape installed 
 

A31p Double click ‘Shuttle Apps’ > ‘NASA Video Overlay’ 
√‘NASA Video Overlay’ window displayed 
Sel ‘Full Screen’ 
Press ‘ESC’ or ‘W’ key to minimize display as reqd 
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P/TV02   DOCK (Continued) 

OPS 

√ Item # 
Track # Rqmts Still Imagery 

Video
Notes 

PLB CC Dnlk
 1. 

 
17A-7 

PAO Coverage D2Xs
12-24mm 
If exterior: 

Flash ON/OFF – 
OFF

As desired G1 
Tape installed 

LIVE
(if avail) 

Plan for end of day crew 
choice video,DCS 

 2. 
 

17A-4 

Rendezvous D2Xs 
400mm(80-200mm) 
Flash ON/OFF – OFF 

A(B,C,D), ELB G1 
As desired 

Map ISS surfaces w/30% 
overlap • Overall 

• Closeup 
• Damage 
• Deterioration 

 3. 
 

17A-22 

Approach,Dock D2Xs (Shutter)
400mm(80-200mm) 
Flash ON/OFF – OFF 

C/L
Per RNDZ 
 
A(D) 
Per RNDZ 
 
C(B) 
Docking view

G1 
As desired 

Rcd C/L Camr video thru 
hard dock on DTV 

Continually √focus 
sharpness 

• PMA2 Docking Target
• PMA2 Mating Surfaces
• PMA2 TCS Planar and 

Hemispherical Retro 
Reflectors 
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P/TV02   DOCK (Continued) 

OPS (Continued) 

 

APPROACH/DOCKING RQMTS

Mapping of ISS Module Surfaces

PMA2 APDS Area

C/L Camr

Camr A(D)

Camr C(B)

170 ft 30 ft
D
O
C
K
E
D

O
P
S

MON 1,
DTV (RCD)

MON 2

7 ft
Dock500 ft

Docking View

Range
Ruler

200 ft

w/80-200mm Lens
D2Xs Camr

400 ft

D2Xs Camr
w/400mm Lens

jsc48037_128_003.cvx

PAO Views D2Xs Camr
w/12-24mm Lens
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P/TV02   DOCK (Concluded) 

OPS (Concluded) 

If OPS temporarily suspended, perform DEACTIVATION as reqd 
If OPS completed, go to DEACTIVATION 

 
DEACTIVATION 

 1. D2Xs 
√Exp Mode – P 
Pwr – OFF 
√Flash ON/OFF – ON 

 
 2. TV System 
R12 (VPU) √Green Jumper – SEC C/L 

√SEC C/L Cap installed 
√VPU PWR – ON (LED on) 

A7 VID OUT MON 1 pb – push 
VID IN PL2(VPU) pb – push 
CAMR CMD IRIS – CL 

L12 (SSP 2) C/L CAM PWR – OFF 
 

ODS Remove, stow C/L camr, Harness Assy, Bridge 
Go to DEACTIVATION (Cue Card, TV) as reqd 

 
 3. G1 

PWR dial – “green”  
Install Wide Conversion Lens 
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P/TV03   UNDOCK 

H/W SUMMARY 
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 FS 1-25 P/TV/128/FIN 

P/TV03   UNDOCK (Continued) 

SCENE SYNOPSIS 
Scene contains procedures for obtaining video,still photos of ISS undocking,flyaround 

 
SETUP 
 1. Perform ACTIVATION,OPERATION (Cue Card, TV) as reqd 

 
 2. Perform D2Xs PROGRAM w/FLASH for in-cabin imagery 

 
Lens – 12-24mm 
Aperture – Min, locked 
Body Focus Mode – S 
√Batt installed 
√Flash Card installed 
Pwr – ON 
Top LCD: 
√Batt 
√Frames remaining sufficient 

Exp Comp (      ) – 0.0 
Exp Mode – P 
Meter – Matrix (     ) 
Diopter – Adjust 
Frame Rate – S 
√BKT disabled – 0 F 
Rear LCD: 
√ISO – 100 
√QUAL – RAW 
√WB – 0,A 

AF Area Mode – [ [  ] ] 
√Focus Area – Center 
√Focus Selector Lock – L 

 
SB-800 Flash Settings: 

ON/OFF pb – ON 
√Diffuser Dome installed 
√MODE –  TTL BL  
√Exp Comp – 0 EV 

Tilt – 45° (Direct) 
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P/TV03   UNDOCK (Continued) 

SETUP (Continued) 

 3. Perform D2Xs MANUAL for undocking/external imagery 
 

Remove ovhd window shields 
Lens – 400mm(80-200mm) 
If 400mm: 

Focus Limit – ∞ -6m 
Lens Focus Mode – A 

If 80-200mm: 
Focus Limit – full 
Lens Focus Mode – M/A 

Aperture – Min, locked 
Body Focus Mode – S 
√Batt installed 
√Flash Card installed 
Pwr – ON 
Top LCD: 
√Batt 
√Frames remaining sufficient 

Exp Comp (      ) – 0.0 
Exp Mode – M: 

SS – 500 
f/stop – 8 

Meter – Matrix (     ) 
Diopter – Adjust 
Frame Rate – S 
√BKT disabled – 0 F 
Rear LCD: 

√ISO – 100 
√QUAL – RAW 
√WB – 0,A 

AF Area Mode – [ [  ] ] 
√Focus Area – Center 
√Focus Selector Lock – L 

 
SB-800 Flash Settings: 

ON/OFF pb – OFF 
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P/TV03   UNDOCK (Continued) 

SETUP (Continued) 
 4. Perform Hardware Verification for V10s, FD CC, DTV 

 
O19 √TV PWR – ON 

 
R12 (VPU) √VPU PWR – ON (LED on) 

√Green Jumper – SEC C/L 
√SEC C/L Cap installed 

 
V10 PWR – ON 
 (MON 1,2) 

√Tape installed 
DISPLAY pb – Toggle to display tape counter 

 
For in-cabin views: 

CC √Wide Conversion lens installed 
√ND FILTER – OFF 
√OUTPUT – CAM 
√  
√STANDBY/LOCK – STANDBY 

PWR dial – “green”  
√Tape installed 

Open LCD: 
√“green”  •|| displayed 
Install Audio Muting Plug (optional) 
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P/TV03   UNDOCK (Continued) 

SETUP (Concluded) 
 4. Perform Hardware Verification for V10s, FD CC, DTV (Concluded) 

 
For sunlit ISS views: 

CC  Remove Wide Conversion Lens 
Install fresh Batt as reqd 

√ND FILTER – OFF 
AF/M – M 
AGC – OFF 
GAIN – L 

√OUTPUT – CAM 
√AWB – ON 
√ 
√STANDBY/LOCK – STANDBY 

PWR dial – M  
√Tape installed 

Open LCD: 
√“green”  •|| displayed 
SS – 1/500 
√GAIN – 0dB 
f/stop – F8.0 
√FOCUS – M ∞- (adjust as reqd) 
Install Audio Muting Plug (optional) 

 
MON 2 SOURCE – C 
L10 (MUX) VTR/CC PWR – on (LED on) 

If dnlk, MUX/VTR/CC PWR – on (LED on) 
L10 (VIP) PWR – on (LED on) 
L10 (VTR) ON/STANDBY LED – green 

√Tape installed 
 

A31p Double click ‘Shuttle Apps’ > ‘NASA Video Overlay’ 
√‘NASA Video Overlay’ window displayed 
Sel ‘Full Screen’ 
Press ‘ESC’ or ‘W’ key to minimize display as reqd 
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P/TV03   UNDOCK (Continued) 

OPS 

√ Item # 
Track # Rqmts Still Imagery 

Video
Notes 

PLB CC Dnlk
 1. 

 
17A-7 

PAO Coverage D2Xs
12-24mm 
If exterior: 

Flash ON/OFF – 
OFF 

As desired G1 
Tape installed 

LIVE
(if avail) 

Plan for end of day crew 
choice video,DCS 

 2. 
 

17A-2 
17A-23 

 
17A-16 

Undock and Flyaround D2Xs
80-200mm(400mm) 
Flash ON/OFF – OFF 

A(D)
Per RNDZ 

G1 
Tape installed 

Map ISS surfaces w/30% 
overlap • Docking Tgt/Mating 

Surfaces 
• TCS Planar, 

Hemispherical Retro 
Reflectors 

C/L
Docking tgt 

and PAO 
view 

LIVE
(if avail) 

• Surfaces 
• Solar Panels 
• Handrails 
• SM Thrusters on 

Zenith, near aft end
• Trusses including 

rads/baseplates and 
SAWs (in/outboard 
SABB insulation 
degradation) 
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P/TV03   UNDOCK (Continued) 

OPS (Continued) 

 

UNDOCKING/FLYAROUND RQMTS

PMA2 APDS Area

Mapping of ISS Module Surfaces

C/L Camr

Camr C

Camr A(D) (flyaround at 400 ft)
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K
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P
S

100 ft

D2Xs Camr
w/80-200mm Lens

MON 1

D2Xs Camr
w/400mm Lens

DTV

(At 400 ft only)

jsc48038_128_004.cvx

Camr A(D)MON 2
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w/12-24mm Lens
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P/TV03   UNDOCK (Concluded) 

OPS (Concluded) 

If OPS temporarily suspended, perform DEACTIVATION as reqd 
If OPS completed, go to DEACTIVATION 

 
DEACTIVATION 

 1. D2Xs 
√Exp Mode – P 
Pwr – OFF 
√Flash ON/OFF – ON 

 
 2. TV System 
R12 (VPU) √Green Jumper – SEC C/L 

√SEC C/L Cap installed 
√VPU PWR – ON (LED ON) 

A7U VID OUT MON 1 pb – push 
VID IN PL2(VPU) pb – push 
CAMR CMD IRIS – CL 

L12 (SSP 2) C/L CAM PWR – OFF 
 

ODS Remove, stow C/L Camr, Harness Assy 
Go to DEACTIVATION (Cue Card, TV) as reqd 

 
 3. G1 

PWR dial – “green”  
Install Wide Conversion Lens 
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P/TV04   INGRESS/EGRESS 

H/W SUMMARY 

INGRESS TV CONFIG 

jsc48038 128 005r1.cvx

Wide
Conversion

Lens

Wireless Video System
Interface Box

VIDEO PROCESSING UNIT

(R12)

ISS

CCTV PL3

MD CC

WorklightBatt
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P/TV04   INGRESS/EGRESS (Continued) 

SCENE SYNOPSIS 

Scene contains procedures for documenting ISS ingress/egress w/video and still photos 
 

SETUP 
 1. Config ISS Video 

 
Perform ACTIVATION (Cue Card, TV) for DNLK OPS of ISS signal as reqd 

R12 (VPU) Green Jumper – ISS 
√VPU PWR – ON 

 
A7 VID OUT DNLK pb – push 

VID IN PL2(VPU) pb – push 
 

 2. Perform Ingress Camcorder Setup 
Obtain two Batts, one for CC and one spare 
Install Batt 

 
CC Install Wide Conversion lens 

√ND FILTER – OFF 
√OUTPUT – CAM 
√  
√STANDBY/LOCK – STANDBY 
PWR dial – “green”   
√Tape installed 
√Viewfinder (LCD) displays “green”  •|| 
Install Audio Muting Plug (optional) 
Install Multiuse Brkt 

 
CAUTION 

Due to temp constraints, worklights at full 
pwr for 45 min; half pwr for unlimited time

 
Worklights Install fresh Batts 

Mount light on CC 
PWR – as reqd 
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P/TV04   INGRESS/EGRESS (Continued) 

SETUP (Concluded) 

 3. Perform D2Xs PROGRAM w/FLASH 
 

Lens – 12-24mm 
√Aperture – Min, locked 
Body Focus Mode – S 
√Batt installed 
√Flash Card installed 
Pwr – ON 
Top LCD: 
√Batt 
√Frames remaining sufficient 

 
Exp Comp (      ) – 0.0 
Exp Mode – P 
Meter – Matrix (     ) 
Diopter – Adjust 
Frame Rate – S 
√BKT disabled – 0 F 
Rear LCD: 
√ISO – 100 
√QUAL – RAW 
√WB – 0,A 

AF Area Mode – [ [  ] ] 
√Focus Area – Center 
√Focus Selector Lock – L 

 
SB-800 Flash Settings: 
√Diffuser Dome installed 

ON/OFF pb – ON 
√MODE –  TTL BL  
√Exp Comp – 0 EV 

Tilt – 45° (Direct) 
 

P/TV/128/FIN 2 



 FS 1-37 P/TV/128/FIN 

P/TV04   INGRESS/EGRESS (Concluded) 

OPS 

√ Item # 
Track # Rqmts Still Imagery 

Video
Notes 

PLB CC Dnlk
 1. 

 
17A-7 

Hatch Opening, Ingress 
Hatch Close, Egress 

D2Xs
12-24mm  

G1 
 

LIVE
(if avail) 

 
If OPS temporarily suspended, perform DEACTIVATION as reqd 
If OPS completed, go to DEACTIVATION 

 
DEACTIVATION 
 1. D2Xs 

Pwr – OFF 
 

 2. TV System 
Go to DEACTIVATION (Cue Card, TV) as reqd 
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P/TV05   ISS INTERNAL OPS 

H/W SUMMARY 

 

        P/TV05 
ISS INT OPS 

jsc48038_128_006a.cvx
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P/TV05   ISS INTERNAL OPS (Continued) 

H/W SUMMARY (Concluded) 

Wireless Video System
Interface Box

VIDEO PROCESSING UNIT

(R12)

ISS
CCTV PL3

jsc48038_128_006br2.cvx
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P/TV05   ISS INTERNAL OPS (Continued) 

SCENE SYNOPSIS 

Scene contains procedures for setup, documenting ISS internal ops (surveys, PAO events, logistics, transfers, closeouts)  
w/video,still photos 

 
SETUP 

WARNING 
Locate QDs at hatches for ease in locating,disconnecting during hatch closure.  
Route,restrain cables to prevent loose cable lengths which could entrap crew 

 
BPSMU AND RWS CABLES 

 1. Config H/W per H/W SUMMARY, FS 1-40 and FS 1-41 
 

MF43E Retrieve second BPSMU, connect internal battery, temp stow in ODS for contingency use 
 

Config RWS Vid Cables: 
MON 1,2 √RWS 1 Drag-Thru Cable connected to MON 1 AVIU J6 
 (Stow-n-Go) 
L10:A1 √RWS 2 Drag-Thru Cable connected to DTV VTR OUT connector 

 
Config BPSMU and RWS Cables: 

ODS/PMA2 Connect orbiter RWS 1,2 Cables to Drag-Through QD Box 
Connect BPSMU Cables to orbiter A/L CCU 1,2 and Drag-Through QD Box 
Config A/L ATU per Comm Plan 

 
If V10: 

ISS  √Pwr configured per P/TV121 DOCKED OPERATIONS, dwg USOS 120VDC –V10 VTRs (SODF: ISS PTV: SCENES) 
V10 (RWS 1,2) PWR – ON 

~ 

P/TV/128/FIN 1 
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P/TV05   ISS INTERNAL OPS (Continued) 

SETUP (Continued) 
BPSMU AND RWS CABLES (Concluded) 

~ 
 

If A31p: 
If A31p w/‘NASA Video Monitor’ under Station Apps: 
√Drag-Thru Cable connected to A31p Video Adapter 

A31p √PWR – ON 
Sel ‘Station Apps: NASA Video Monitor’ 

√‘NASA Video Monitor 1.0.0.0’ window displayed 
Sel ‘Settings’ 

√‘Configuration’ window displayed 
Video Input Standard: – NTSC 
  √Input – ‘Composite (RCA)’ 
Video Control – press ‘Set to defaults’ pb 
Commit Changes – ‘OK’ 
Sel ‘Full Screen’ 
Press ‘ESC’ to minimize display as reqd 

If A31p w/‘COSS Apps: Video Converter’ under Station Apps: 
√Drag-Thru Cable connected to A31p Video Adapter 

A31p √PWR – ON 
Sel ‘Station Apps: COSS Apps: Video Converter’ 

√‘Video Converter’ window displayed 
Sel ‘Set Properties’ 

√‘Video Settings’ window displayed 
Format: – NTSC 
Close ‘Video Settings’ window 
Sel ‘Full Screen’ 
Press ‘ESC’ or ‘W’ to minimize display as reqd 

 
PAO EVENT 

 1. Config VPU 
 

R12 (VPU) √Green Jumper – ISS 
√VPU PWR – ON (LED on) 

 
 2. Config Shuttle Video 

 
A7 VID OUT DNLK pb – push 

VID IN PL2(VPU) pb – push 
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P/TV05   ISS INTERNAL OPS (Continued) 

SETUP (Concluded) 

STILL CAMR 
 1. Perform D2Xs PROGRAM w/FLASH 

 
Lens – 12-24mm 

√Aperture – Min, locked 
Body Focus Mode – S 

√Batt installed 
√Flash Card installed 

Pwr – ON 
Top LCD: 

√Batt 
√Frames remaining sufficient 

Exp Comp (      ) – 0.0 
Exp Mode – P 
Meter – Matrix (     ) 
Diopter – Adjust 
Frame Rate – S 

√BKT disabled – 0 F 
Rear LCD: 

√ISO – 100 
√QUAL – RAW 
√WB – 0,A 

AF Area Mode – [ [  ] ] 
√Focus Area – Center 
√Focus Selector Lock – L 

 
SB-800 Flash Settings: 

√Diffuser Dome installed 
ON/OFF pb – ON 

√MODE –  TTL BL  
√Exp Comp – 0 EV 

Tilt – 45° (Direct) 
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P/TV05   ISS INTERNAL OPS (Concluded) 

OPS 

√ Item # 
Track # Rqmts Still Imagery 

Video
Notes 

PLB CC Dnlk
 1. General ISS IVA Activity D2Xs

12-24mm 
For Crew Photo: 

Perform D2Xs 
CREW PHOTO 
(Cue Card, D2Xs 
SETUP)

 
ISS G1 
 

LIVE
(if avail) 

Plan for end of day crew 
choice video 

• PAO Scenes of 
Interest 

• Crew Photo 

 
If OPS temporarily suspended, perform DEACTIVATION as reqd 
If OPS completed, go to DEACTIVATION 

 
DEACTIVATION 

 1. D2Xs 
Pwr – OFF 

 
 2. Drag-Through QD Box 

Disconnect: 
RWS Cables (two) from orbiter side Video 1,2 ports.  Stow cables on orbiter 
BPSMU Cables from orbiter side BPSMU 1,2 and ODS CCU ports; stow cables on orbiter 

Transfer Drag-Through QD Box and remaining attached cables to ISS 
 

 3. Temp Stowed BPSMU 
ODS Remove temp-stowed BPSMU from ODS location.  Stow in MF43E 

 
 4. TV System 

Go to DEACTIVATION (Cue Card, TV) as reqd 
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 FS 1-48 P/TV/128/FIN 

P/TV06   ROBOTICS OPERATIONS 

H/W SUMMARY 

FD TV Pwr
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J6

J1
75
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LO
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AVIU-CC Video Cable
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Video

MON
1

V10

J1
75
J5

LO
J3
J7

J2
VIDEO
J4

J6

R
L
V

jsc48038_128_016r5.cvx

ISS

VIDEO PROCESSING UNIT

MON 1 AVIU Cable

MON 1 TV Pwr
Cable (10 ft)

Digital CC Vid/Pwr
Cable (15 ft)

AVIU-CC Video Cable

(Not
Used)
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R
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RWS 1
VIU-CM
Cable
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RWS 1
BNC Vid

Cable

Video 2

Video 1

Video 2

Video 1

BNC Straight Adapters
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 FS 1-49 P/TV/128/FIN 

P/TV06   ROBOTICS OPERATIONS (Continued) 

SCENE SYNOPSIS 

Scene contains procedures for obtaining video of SSRMS activities 
 

SETUP 

 1. Perform ACTIVATION,OPERATION (Cue Card, TV) as reqd 
 

 2. Perform Hardware Verification for V10s, FD CC, DTV, Keel Camr 
 

O19 √TV PWR – ON 
 

R12 (VPU) √VPU PWR – ON (LED on) 
Green Jumper – LDRI/ITVC 

 
√Drag-Thru Cables configured as reqd 

 
V10 PWR – ON 
 (MON 1,2) √Tape installed 

DISPLAY pb – Toggle to display tape counter 
 

CC √Wide Conversion lens installed 
√ND FILTER – OFF 
√OUTPUT – CAM 
√  
√STANDBY/LOCK – STANDBY 
PWR dial – “green”  
√Tape installed 
√Viewfinder (LCD) displays “green”  •|| 
Install Audio Muting Plug (optional) 
Install Multiuse Brkt 

 
MON 2 SOURCE – C 
L10 (MUX) VTR/CC PWR – on (LED on) 

If dnlk, MUX/VTR/CC PWR – on (LED on) 
L10 (VIP) PWR – on (LED on) 
L10 (VTR) ON/STANDBY LED – green 

√Tape installed  
P/TV/128/FIN 1 



 FS 1-50 P/TV/128/FIN 

P/TV06   ROBOTICS OPERATIONS (Continued) 

SETUP (Concluded) 

 3. MPLM Reberth: 
R12 (VPU) √VPU PWR – ON 

Green Jumper – KEEL 1 
L12 (SSP 2) √cb SW PWR 3 – cl 

√MPLM KEEL CAM HTR/ILLUM PWR – ON 
MPLM KEEL CAM PWR – ON 

 
OPS 

√ Item # 
Track # Rqmts 

Still Imagery Video
Notes 

DCS PLB CC Dnlk
 1. 

 
17A-7 

PAO Coverage D2Xs
12-24mm 
If exterior: 

Flash ON/OFF – 
OFF

As desired G1 
Tape installed 

LIVE
(if avail) 

Plan for end of day crew 
choice video,DCS 

 2. 
 

17A-20 

MPLM XFER TO ISS 
 

Per SODF: 
ROBO FS 

 
 

Rcd video
• SSRMS Grapple,Release
• ROEU Disconnect 
• PRLA,Keel Latch Release
• Unberth,Hover 
• Positioning Mnvrs for CBM 

Seal Inspection 
• Premate Mnvr of MPLM to 

Node 2 
• Matings 
• Capture 
• Securing MPLM to NODE 2
• SSRMS Release 
• Still Photo of RWS Monitor 

w/CBCS Overlay and 
CBCS Camr View of 
MPLM Target 

D2Xs
28-70mm 
EXP Mode – S 

SS:  1/30 sec 
Flash ON/OFF – ON
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P/TV06   ROBOTICS OPERATIONS (Concluded) 

OPS (Concluded) 

√ Item # 
Track # Rqmts 

Still Imagery Video
Notes 

DCS PLB CC Dnlk
 3. 

 
17A-20 

MPLM XFER to PLB 
 

Per SODF: 
ROBO FS 

 
 

Rcd video
• Removal 
• Berthing 
• PRLA Latching 
• ROEU Connect 

 
If OPS temporarily suspended, perform DEACTIVATION as reqd 
If OPS completed, go to DEACTIVATION 

 
DEACTIVATION 

 1. TV System 
L12 (SSP2) MPLM KEEL CAM PWR – OFF 

  √HTR/ILLUM PWR – ON 
 

Go to DEACTIVATION (Cue Card, TV) as reqd 
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P/TV07   EVA 

H/W SUMMARY 
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ISS

VIDEO PROCESSING UNIT
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 FS 1-53 P/TV/128/FIN 

P/TV07   EVA (Continued) 

SCENE SYNOPSIS 
Scene contains procedures for documenting ISS EVA and IVA ops w/video,still photos  

SETUP 
FOR ALL EVAs: 

 1. Perform ACTIVATION,OPERATION (Cue Card, TV) as reqd  
 2. Perform D2Xs PROGRAM w/FLASH  

Lens – 12-24mm 
√Aperture – Min, locked 
Body Focus Mode – S 
√Batt installed 
√Flash Card installed 
Pwr – ON 
Top LCD: 
√Batt 
√Frames remaining sufficient 

Exp Comp (      ) – 0.0 
Exp Mode – P 
Meter – Matrix (     ) 
Diopter – Adjust 
Frame Rate – S 
√BKT disabled – 0 F 
Rear LCD: 
√ISO – 100 
√QUAL – RAW 
√WB – 0,A 

AF Area Mode – [ [  ] ] 
√Focus Area – Center 
√Focus Selector Lock – L  
SB-800 Flash Settings: 
√Diffuser Dome installed 

ON/OFF pb – ON 

√MODE –  TTL BL  
√Exp Comp – 0 EV 

Tilt – 45° (Direct) 
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P/TV07   EVA (Continued) 

SETUP (Continued) 

 3. Perform Hardware Verification for V10s, FD CC, DTV 
 

O19 √TV PWR – ON 
 

R12 (VPU) √VPU PWR – ON (LED on) 
√Green Jumper – ISS 

 
V10 PWR – ON 
 (MON 1,2, √Tape installed 
 WVS 1,2) DISPLAY pb – Toggle to display tape counter 

 
CC Install Wide Conversion lens 

√ND FILTER – OFF 
√OUTPUT – CAM 
√  
√STANDBY/LOCK – STANDBY 
PWR dial – “green”  
√Tape installed 
√Viewfinder (LCD) displays “green”  •|| 
Install Audio Muting Plug (optional) 
Install Multiuse Brkt 

 
MON 2 SOURCE – C 
L10 (MUX) VTR/CC PWR – on (LED on) 

If dnlk, MUX/VTR/CC PWR – on (LED on) 
L10 (VIP) PWR – on (LED on) 
L10 (VTR) ON/STANDBY LED – green 

√Tape installed 
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P/TV07   EVA (Continued) 

SETUP (Concluded) 

 4. Config WVS and PGSC 
 

 a. Activate WVS System 
 

A7  √WIRELESS VID HTR – ON 
WIRELESS VID PWR – ON 

 
 b. WVS PGSC Prep 

 
PGSC Pwrup and Application Opening 

PGSC Pwr – ON 
Sel Shuttle Apps icon 
Sel WVS icon 
Sel ‘No’ at ‘Restore To Previous Settings’ window 

 
If ‘Comm Port Configuration’ error displayed: 

Remove Quatech RS-422 Card 
Sel ‘Start’> ‘Shut Down’> ‘Shut Down’> ‘OK’ 
Reinstall Quatech RS-422 Card 
Pwr – ON 
Sel Shuttle Apps icon 
Sel WVS icon 

RF Camera page will appear 
 

NOTE 
During EVA prep, EMU TV assy will be pwrd 

 
Application Setup 
Select Page – XCVR 
Transceiver 1(2) CMD Power – ON (green CMD PWR:LVL- “ON:Min”) 
RF Camera 1 – One EVA crewmember (green “ON”) 
RF Camera 2 – Other EVA crewmember (green “ON”) 

 
If alert msg, perform ALERT MSG TROUBLESHOOTING (Cue Card, WVS) 

 
Select Page – RF CAMERA 

 
Near middle of RF Camera page, sel ‘Advanced Controls’ 

 
When Post-A/L Depress: 

For center lens on each RF Camr Assy: 
Lens Iris Cntl – op(cl) until good video on V10(MON) 
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P/TV07   EVA (Concluded) 
OPS 

Video 
√ Item # 

Track # Rqmts Still Imagery 
PLB CC Dnlk 

Notes 

 1. 
 

17A-7 

PAO Coverage IVA D2Xs 
12-24mm 
If exterior: 

Flash ON/OFF – OFF

As desired 
WVS 

G1 
As desired 

LIVE 
(if avail) 

Plan for end of day crew 
choice video, DCS stills 

 
If OPS temporarily suspended, perform DEACTIVATION as reqd 
If OPS completed, go to DEACTIVATION 

 
DEACTIVATION 

 1. IVA D2Xs 
Pwr – OFF 
√Flash ON/OFF – ON 
Download images 

 
 2. TV System 

Perform PWRDN (Cue Card, WVS) 
Go to DEACTIVATION (Cue Card, TV) as reqd 
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P/TV08   EXTERNAL SURVEY 
SCENE SYNOPSIS 

Scene contains procedures for documenting STS,ISS external structures w/still photos during general survey activities 
 

SETUP 

 1. D2Xs Camr Configuration for OMS Pod Survey 
 

Remove aft window shields 
If Sunlit OMS Pod, config D2Xs Manual Mode: 

Lens – 80-200mm at 200mm 
Focus Limit – full 
Lens Focus Mode – M/A 
Aperture – Min,locked 
Body Focus Mode – S 

√Batt installed 
√Flash Card installed 

Pwr – ON 
Top LCD: 
√Batt 
√Frames remaining sufficient 

Exp Comp (      ) – 0.0 
Exp Mode – M: 

SS – 1000 
f/stop – F8 

Meter – Matrix (     ) 
Diopter – Adjust 
Frame Rate – S 

√BKT disabled – 0 F 
Rear LCD: 
√ISO – 100 
√QUAL – RAW 
√WB – 0,A 

AF Area Mode – [ [  ] ] 
√Focus Area – Center 
√Focus Selector Lock – L  

SB-800 Flash Settings: 
ON/OFF pb – OFF 

~ 

  P/TV08 
EXT SURVEY       
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P/TV08   EXTERNAL SURVEY (Continued) 

SETUP (Continued) 

 1. D2Xs Camr Configuration for OMS Pod Survey (Concluded) 
 

~ 
 

If Earthshine OMS Pod, config D2Xs Program Mode: 
Lens – 80-200mm at 200mm 
Focus Limit – full 
Lens Focus Mode – M/A 

√Aperture – Min, locked 
Body Focus Mode – S 

√Batt installed 
√Flash Card installed 

Pwr – ON 
Top LCD: 
√Batt 
√Frames remaining sufficient 

Exp Comp (      ) – 0.0 
Exp Mode – P 
Meter – Matrix (     ) 
Diopter – Adjust 
Frame Rate – S 

√BKT disabled – 0 F 
Rear LCD: 
√ISO – 100 
√QUAL – RAW 
√WB – 0,A 

AF Area Mode – [ [  ] ] 
√Focus Area – Center 
√Focus Selector Lock – L 

 
SB-800 Flash Settings: 

ON/OFF pb – OFF 
 

P/TV/128/FIN 2 
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P/TV08   EXTERNAL SURVEY (Continued) 

SETUP (Continued) 

 2. D2Xs Camr Config for ISS Still Survey (D2Xs Shutter Priority Mode) 
 

Lens – 50mm(80-200mm @ 200mm) 
If 80-200mm: 

Focus Limit – full 
Lens Focus Mode – M/A 

√Aperture – Min, locked 
Body Focus Mode – S 
√Batt installed 
√Flash Card installed 
Pwr – ON 
Top LCD: 
√Batt 
√Frames remaining sufficient 

Exp Comp (      ) – 0.0 
Exp Mode – S: 

SS – 500 
Meter – Matrix (    ) 
Diopter – Adjust 
Frame Rate – S 
√BKT disabled – 0 F 
Rear LCD: 
√ISO – 100 
√QUAL – RAW 
√WB – 0,A 

AF Area Mode – [ [  ] ] 
√Focus Area – Center 
√Focus Selector Lock – L 

 
SB-800 Flash Settings: 

ON/OFF pb – OFF 
 

P/TV/128/FIN 2 
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P/TV08   EXTERNAL SURVEY (Continued) 

SETUP (Concluded) 

 3. D2Xs Camr Config for SEITE(SIMPLEX) (D2Xs Shutter Priority Mode) 
 

Lens – 28mm 
√Aperture – Min, locked 
Body Focus Mode – S 
√Batt installed 
√Flash Card installed 
Pwr – ON 
Top LCD: 
√Batt 
√Frames remaining sufficient 

Exp Comp (      ) – 0.0 
Exp Mode – S: 

SS – 500 
Meter – Matrix (     ) 
Diopter – Adjust 
Frame Rate – S 
√BKT disabled – 0 F 
Rear LCD: 
√ISO – 100 
√QUAL – RAW 
√WB – 0,A 

AF Area Mode – [ [  ] ] 
√Focus Area – Center 
√Focus Selector Lock – L 

 
Accessory Equipment: 

Shutter Release Cable – install 
Multiuse Base – install in W9/10 
Multiuse Brkt – install on Base 

 
SB-800 Flash Settings: 

ON/OFF pb – OFF 
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P/TV08   EXTERNAL SURVEY (Continued) 
OPS 

√ Item # 
Track # 

Rqmts Still Imagery Video Notes PLB CC Dnlk
 1. OMS Pod Survey D2Xs

80-200mm @ 200mm 

   

Download images to MCC once 
complete 

 
•√No shadows on OMS pod 

tiles 
• Remove window shields
• 50 percent overlap 

mapping of both OMS 
pods and vertical 
stabilizer w/emphasis on 
Black Tile areas

• Repeat thru other window

 2. 
 

17A-4 

ISS Still Survey D2Xs
50mm 

(80-200mm @ 
200mm) 

 

 
 
  

Map ISS surfaces w/30% overlap 
from all Flt Deck windows • Surfaces 

• Solar Panels 
• Handrails 
• MISSE 
• Plasma Arcing 
• S0,S1,S3,S4,S5,P1,P3,P4, 

P5,P6 Truss Radiators/ 
Baseplates, SAWs 

• ESP-2 
• P6 Fwd PVR Base Bubble

 3. 
 

17A-5 

SEITE(SIMPLEX) D2Xs
28mm 

 Initial photo within 5 sec of burn
• Obtain minimum of one 

photo at beginning, 
middle,end of OMS Burn

P/TV/128/FIN 1 
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P/TV08   EXTERNAL SURVEY (Continued) 

OPS (Continued) 

 

Priority of ISS Photographic Targets During Docked Phase: 
1. P6, P5, P3/P4, ESP 3, P1, JEM, JLP, Columbus, S1, 

S3/S4, S5, S6, Solar Arrays – W1, W6 
2. Node 2, Columbus, JEM, JLP – W7, W8 
3. PMA2 – W9, W10 

P/TV/128/FIN 1 
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P/TV08   EXTERNAL SURVEY (Concluded) 

OPS (Concluded) 

If OPS temporarily suspended, perform DEACTIVATION as reqd 
If OPS completed, go to DEACTIVATION 

 
DEACTIVATION 

 1. D2Xs 
√Exp Mode – P 
PWR – OFF 
Flash ON/OFF – ON 
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P/TV09   MIDDECK PAYLOADS 

H/W SUMMARY 

jsc48038_128_017r1.cvx

Bracket optional

CC on Batt Pwr

Multiuse
Arm

MD CC

Audio Meeting Plug
(optional)

 

P/TV09 
MIDDECK PL         
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P/TV09   MIDDECK PAYLOADS (Continued) 

SCENE SYNOPSIS 

Scene contains procedures for obtaining in-cabin video conducted within orbiter/ISS 
 

SETUP 

 1. Perform Camcorder Setup for MD per H/W SUMMARY, FS 1-66, as reqd 
 

√Batt installed 
CC Install Wide Conversion lens 

√ND FILTER – OFF 
√OUTPUT – CAM 
√  
√STANDBY/LOCK – STANDBY 
PWR dial – “green”  
√Tape installed 
√Viewfinder (LCD) displays “green”  •|| 
Install Audio Muting Plug (optional) 
Install Multiuse Brkt 
PWR dial – OFF 
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P/TV09   MIDDECK PAYLOADS (Continued) 

SETUP (Concluded) 

 2. Perform D2Xs PROGRAM w/FLASH 
 

Lens – 12-24mm 
Aperture – Min, locked 
Body Focus Mode – S 
√Batt installed 
√Flash Card installed 
Pwr – ON 
Top LCD 
√Batt 
√Frames remaining sufficient 

Exp Comp (     ) – 0.0 
Exp Mode – P 
Meter – Matrix (     ) 
Diopter – Adjust 
Frame Rate – S 
√BKT disabled – 0 F 
Rear LCD 
√ISO – 100 
√QUAL – RAW 
√WB – 0,A 

AF Area Mode – [ [  ] ] 
√Focus Area – Center 
√Focus Selector Lock – L 

 
SB-800 Flash Settings 
√Diffuser Dome installed 

ON/OFF pb – ON 
√MODE –                      
√Exp Comp – 0 EV 

Tilt – 45° (Direct) 
 

TTL BL
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P/TV09   MIDDECK PAYLOADS (Concluded) 

OPS 

√ Item # 
Track # Rqmts 

Still Imagery Video 
Notes 

DCS PLB CC Dnlk 
 1. 

 
17A-11 

GLACIER Video,Still 
Photography 

D2Xs
12-24mm 

G1 PLAYBACK 
desired 

• Wide-angle video, photos 
showing crew interaction 

• Medium-angle video, photos 
showing stowage location

• Closeup video, photos of 
front panel after activation 
for gnd verification 

 
If OPS temporarily suspended, perform DEACTIVATION as reqd 
If OPS completed, go to DEACTIVATION 
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 FS 2-1 P/TV/128/FIN 

REFERENCED PROCEDURES 

 PAGE 

CENTERLINE (C/L) CAMR 
C/L CAMR INSTALL ...................................................................................................................................................................................  FS 2-4 

DTV 
VTR CLOCK SET .......................................................................................................................................................................................  FS 2-8 

D2Xs 
DATE/TIME SET .........................................................................................................................................................................................  FS 2-10 

CANON G1 
ANALOG (SD) CC REC,DNLK ...................................................................................................................................................................  FS 2-12 
HD CC DNLK ..............................................................................................................................................................................................  FS 2-14 

FCS CHECKOUT CAMR SETUP 
SETUP ........................................................................................................................................................................................................  FS 2-18 
DEACTIVATION .........................................................................................................................................................................................  FS 2-19 

MINI-CAM 
ENTRY VIDEO SETUP ...............................................................................................................................................................................  FS 2-22 

LASER CAMR SYSTEM (LCS)/INTEGRATED SENSOR INSPECTION SYSTEM DIGITAL CAMR (IDC) 
LCS/IDC (HEATER ONLY MODE)/(OPERATIONAL PWR MODE) DATA AND PWR INTERFACES .......................................................  FS 2-26 
PTU 2/MAIN BUS B SYSTEM DETAILS ....................................................................................................................................................  FS 2-27 

      REF PROC   
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 FS 2-4 P/TV/128/FIN 

CENTERLINE (C/L) CAMR 

C/L CAMR INSTALL 

 1. ODS C/L Camr Config 
L12 (SSP 2) √C/L CAM PWR – OFF 

 
R12 (VPU) √SEC C/L Cap installed 

√Green Jumper – SEC C/L 
√VPU PWR – ON (LED on) 

 
ML60B Unstow PRI C/L Camr, PRI C/L TV Camr Harness Assy 

 
NOTE 

When connecting ODS C/L TV 
Camr Harness Assy, √pins to 
socket connection 

 
ODS √ODS C/L Camr Brkt mounted securely 

Mount PRI C/L Camr to ODS C/L Camr Brkt 
√Flex Duct attached to Camr brkt 

Config cable per dwg at right 
 

C/L Camr √SSF/STS sw – STS 
 

L12 (SSP 1) √cb SSP2 SEC C/L CAM – cl 
L12 (SSP 2) C/L CAM PWR – SEC ON 

 

    C/L CAMR     

jsc48037_048r2.cvx

TV
(AW18H)

1 2

ODS
C/L

Camr

Ovhd Hatch

PRI C/L TV Camr Harness Assy
(V828–774057–004)

Pwr,SyncVideo

Wireless Video System
Interface Box

SEC C/L

VIDEO PROCESSING UNIT

SEC
C/L

(R12)

(ODS)
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CENTERLINE (C/L) CAMR (Continued) 

C/L CAMR INSTALL (Continued) 

 2. Camr Position Verification 
 

 

jsc48037_049r2.cvx

Existing
Shims for
Pitch/Yaw
Alignment

FWD

AFT

STBD
PORT

ÊÊÊ

NOTE
This view in ODS looking

up from Camr bottom

Cam r Housing
Bracket
Mounting
Subplate

Axial
Adjustment
Screw

Axial
Adjustment
Screw

TV

1 2

PRI C/L TV Camr Harness Assy (8.5 ft)
V828–774057–004

(ODS)
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jsc48037_050.cnv

CENTERLINE (C/L) CAMR (Concluded) 

C/L CAMR INSTALL (Concluded) 

 3. ODS C/L Camr Alignment Check 
Perform ACTIVATION (Cue Card, TV) as reqd 

 
A7 VID OUT MON 1(2) pb – push 
 VID IN PL2(VPU) pb – push 
 ALC pb – push 
 AVG pb – push 

 
MON 1(2) LDATA – ON 

CDATA – GRN 
XHAIR – GRN 

 
A7 Zoom to 10° ± 0.5° 

Focus to see Xhair target 
 

NOTE 
Green xhairs on monitor may move off center in 
calibration target when zooming in,out.  Xhair 
will be closest to center at full zoom in position 

 
MON 1(2) √Vertical xhairs coincide w/vertical alignment wire and are parallel.  If xhair marks overlay each other, no yaw(axial) alignment 

needed (see dwg above) 
 

√Intersection of monitor vertical, horizontal xhair falls within target circular opening from ~10-40° zoom range of Camr 
 

Report results of both alignment verifications (at 10° and 40°) to MCC 
 

 4. Deactivation 
A7 CAMR CMD IRIS – CL 
L12 (SSP 2) C/L CAM PWR – OFF 

Go to DEACTIVATION (Cue Card, TV) as reqd 
 



 FS 2-7 P/TV/128/FIN 

 

This Page Intentionally Blank 

  DTV       



 FS 2-8 P/TV/128/FIN 

DTV 

VTR CLOCK SET 

 1. Activate VTR 
 

R1 √PL AUX – ON 
 

L10 (MUX) VTR/CC PWR – on (LED on) 
L10 (VTR) √ON/STANDBY LED – green 

 
 2. Set VTR clock to GMT 

 
DISPLAY SELECT – MENU 
↓ pb – ETC, EXEC pb – push 
↓ pb – CLOCK SET, EXEC pb – push 
Use ↑,↓,EXEC to set Y,M,D,hr,min to GMT 

 
DISPLAY SELECT – DATA 

 
 3. Deactivate VTR,VIP as reqd 

 
ON/STANDBY pb – push (red LED on) 

L10 (VIP) PWR – off (LED off) 
 

  DTV       
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 FS 2-10 P/TV/128/FIN 

D2Xs 

DATE/TIME SET 

 1. MENU pb – press 
 2. Navigate pad – sel Menu icon  setup menu 

Navigate pad – press (right) 
Navigate pad – sel WORLD TIME (up,down) 
Navigate pad – press (right) 
Navigate pad – sel DATE (up,down) 
Navigate pad – press (right) 

 3. Set TIME/DATE to GMT 
Navigate pad – sel desired field (left,right) 
Navigate pad – sel desired setting (up,down) 

 4. ENTER pb – press 
 5. MENU pb – press twice 

D2Xs         
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CANON G1 

ANALOG (SD) CC REC,DNLK 

Config H/W per dwg at right 
 

AVIU SYNC/VIDEO – VIDEO 
HI-Z/75 – 75 
PWR SELECT – LO 

 
O19(MO58F) √TV PWR – ON 

 
CC √Wide Conversion lens installed 

√ND FILTER – OFF 
Install Audio Muting Plug (optional) 

√OUTPUT – CAM 
√A/V1/V2 – V2 
√  
√STANDBY/LOCK – STANDBY 

PWR dial – “green”  
If rec to tape: 

Tape – Install 
√Viewfinder (LCD) displays “green”  •|| 

Multiuse Brkt, Clamp 
 

CAUTION 
Due to temp constraints, worklights at full 
pwr for 45 min; half pwr for unlimited time

 
Worklights Install fresh Batts 

Mount light(s) w/brkts (Velcro/tape) 
PWR – as reqd 

 
Cabin Lts Flt Deck – ON 

Lts in FOV – OFF as reqd 
Lt Shades – install as reqd 
Window Shades – install as reqd 

 

        CANON G1 

P/TV/128/FIN 2 

Handheld Mic

CCU

jsc48038_128_020r1.cvx

FLTDECK(MIDDECK)
O19(MO58F)

TV

PIGMY

FD TV Pwr Cable (10 ft)
(2293284–504, 528–20650–1)Pwr Video

CC
AVIU

J2

J4

J6

J1

J5

J3
J7

VIDEO 75

LO

Digital CC Vid/Pwr
Cable (15 ft)

(SED39111490–303)

PwrVideo

FOR PAO EVENTS

Wide
Conversion

Lens

Multiuse
Arm

FD CC

V2

Audio
Muting Plug
(Optional)

RCA-BNC
Adapter

Worklight Worklight
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CANON G1 (Continued) 

ANALOG (SD) CC REC,DNLK (Concluded) 

CC √Scene composition 
 

Adjust Camr angle for best framing 
 

CCU CCU PWR – ON 
 

ATU PWR – AUD 
A/G 1(2) – T/R 
All Other Loops – OFF 
XMIT/ICOM MODE SEL – PTT/PTT 
MSTR SPKR VOL SEL – as reqd 

 
When ready for dnlk: 

A7  √TV DNLK – ENA 
TV PWR CNTL – PNL 
TV PWR CONTR UNIT – MNA(B) 
TV PWR CNTL – CMD (wait 10 sec for system initialization)  

If Analog, on MCC GO: 
VID OUT DNLK pb – push 
VID IN FLT DECK(MIDDECK) pb – push 

If Digital, on MCC GO: 
L10  √Cables connected 
 (MUX)  MUX/VTR/CC PWR – on (LED on) 

√MUX BYPASS – ACT 
 (VIP)  PWR – on (LED on, DATA FLOW LED flashes twice) 
 (VTR)  √ON/STANDBY LED – green 

√INPUT SELECT – VIDEO 
A7  VID OUT DTV pb – push 

VID IN FLT DECK(MIDDECK) pb – push 
L10 (MUX)  √CH 3 DATA LED – on  

When dnlk complete: 
CC  PWR dial – OFF 
Worklights  PWR – off 
L10 (MUX)  MUX/VTR/CC PWR – off (LED off)  

Go to DEACTIVATION (Cue Card, TV) as reqd 

P/TV/128/FIN 1 
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CANON G1 (Continued) 

HD CC DNLK 

Notify MCC, configuring for HD TV dnlk 
 

Config H/W per dwg at right 
 

CC For cable strain relief attach MPC-to-G1 Cable  
Velcro strap to CC strap 

 
AVIU SYNC/VIDEO – VIDEO 

HI-Z/75 – 75 
PWR SELECT – LO 

 
O19 √TV PWR – ON 

 
CC √Wide Conversion Lens installed 

Install LAV MIC 
√ND FILTER – OFF 
√OUTPUT – CAM 
√                     
√STANDBY/LOCK – STANDBY 

PWR dial – “green”   
Mount Camcorder 

 
L10 (MUX) √MUX/VTR/CC PWR – on (LED on) 

√MUX BYPASS – ACT 
√CH 0,1 RATE SEL – 1 
CH √2 RATE SEL – 8  

 (VTR) ON/STBY pb – push (LED red) 
 (VIP) PWR – off (LED off)  
O19 DC UTIL PWR MNA – ON 
MPC PWR DC PWR SPLY PWR SW1 – ON 
MPC SPLY 
MPC PWR – ON (HDV, TAXI, 5V, 3V green LEDs on)  

jsc4803_128_021.cvx

VTR/CC MUX/VTR/CC
ACT

MUX
BYPASS

IEEE 1394
Channel 3

TX RX
Channel 2

RATE
SEL

8

MPC-DTV MUX Cable
(ST-ST Optical Cable)

HDV/DV

N/A

J2
VIDEO
J4

J6
FD

AVIU

J1
75
J5

LO
J3
J7

FLT DECK (O19)

FD TV Pwr Cable (20 ft)

ETHERNET

HDV

DATA OUT 16VDC IN

MPC

P2P1

J2
J1

SW1
DC PWR

SPLY
(White Brick)

P1

P1

J2

S2
DC UTIL

PWR MNA

O19

P2

MPC DC Pwr
Sply Cable (6 ft)

MPC DC Pwr
Cable (10 ft)

MPC-G1 Cable
(DTV IEEE 1394 4-PIN to Male CIRC Cable (5 ft))

P2/P2

P1

Multiuse
Arm

Wide
Conversion

Lens
CC

FOR PAO EVENTS

LAV
MIC

FOR PAO EVENTS

Worklight Worklight
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CANON G1 (Continued) 

HD CC DNLK (Continued) 

L10 (MUX) √CH 2 F/O OK,DATA LEDs on 
 

CAUTION 
Due to temp constraints, worklights at full 
pwr for 45 min; half pwr for unlimited time

 
Worklights Install fresh Batts 

Mount light(s) w/brkts (Velcro/tape) 
PWR – as reqd 

 
Cabin Lts Flt Deck – ON 

Lts in FOV – OFF as reqd 
Lt Shades – install as reqd 
Window Shades – install as reqd 

 
CC √Scene composition 

 
Adjust Camr angle for best framing 

 
LAV MIC PWR – ON (talk),OFF (listen) 

 
√MCC if Black video and color bars reqd  

If reqd:  
PWR dial – Av 
Aperture – close 

√Av CLOSE displayed on top left of LCD 
AGC – OFF 

√GAIN sw – L 
√±0dB displayed on LCD 

OUTPUT – BARS 
 

When MCC says done w/bars: 
OUTPUT – CAM 

 
When MCC says done w/black screen test: 

PWR dial – “green”  
 

P/TV/128/FIN 2 
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CANON G1 (Concluded) 

HD CC DNLK (Concluded) 

When dnlk complete: 
CC  PWR dial – OFF 

 
Worklights  PWR – OFF 

 
O19  TV PWR – OFF as reqd 

 
MPC  PWR – OFF 
MPC PWR  DC PWR SPLY PWR SW1 – OFF 
MPC SPLY 
O19  DC UTIL PWR MNA – OFF 
L10 (MUX)  MUX/VTR/CC PWR – off (LED off) 
 (VIP)  PWR – on (LED on, DATA FLOW LED flashes twice) 
 (VTR)  ON/STANDBY pb – push (LED green) 

 
Notify MCC, returned to SD TV dnlk 

 
Go to DEACTIVATION (Cue Card, TV) as reqd 
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FCS CHECKOUT CAMR SETUP 

SETUP 

 1. D2Xs 
 

Lens – 400mm 
 

NOTE 
If auto focus unachievable: 

Lens Focus Mode – M 
 

Aperture – Min, locked 
Lens Focus Limit – ∞ -6m 
Lens Focus Mode – A 
Body Focus Mode – S 

√Batt installed 
√Flash Card installed 

Pwr – ON 
Top LCD: 
√Batt 
√Frames remaining sufficient 

Exp Comp – 0.0 
Exp Mode – M: 

SS – 500 
f/stop – f/8 

Meter – Matrix 
Diopter – Adjust 
Frame Rate – S 

√BKT disabled – 0 F 
Rear LCD: 
√ISO – 100 
√QUAL – RAW 
√WB – 0,A 

AF Area Mode – [ [ ] ] 
√Focus Area – Center 
√Focus Selector Lock – L 

 
SB-800 Flash Settings: 

ON/OFF pb – OFF 

      FCS   
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FCS CHECKOUT CAMR SETUP (Concluded) 

SETUP (Concluded) 

 2. G1 CC 
 

Remove Wide Conversion Lens 
Install Batt 

√ND FILTER – OFF 
AF/M – M 
AGC – OFF 
GAIN – L 

√OUTPUT – CAM 
√AWB – ON 
√ 
√STANDBY/LOCK – STANDBY 

PWR dial – M  
√Tape installed 

Open LCD: 
√‘green’  •|| displayed 

SS – 1/500 
√GAIN – 0dB 

f/stop – F8.0 
√FOCUS – M ∞- 

 
DEACTIVATION 

 1. D2Xs 
Lens focus mode – A 
EXP Mode – P 
Pwr – OFF 

 
 2. G1 

Install Wide Conversion Lens 
AF/M – AF 
AGC – ON 
Pwr dial – OFF 
Remove Batt 
Connect Dig/CC Vid Pwr Cable 
PWR dial – ‘green’        
Place G1 on brkt 
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MINI-CAM 

ENTRY VIDEO SETUP 

jsc48038_128_008r3.cvx

FLT DECK (O19)

TV

ASC/ENT TV Pwr Cable (10 ft)
(2293284–504/528–20650–1)

Pwr
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    MINI-CAM     
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MINI-CAM (Continued) 

MIDDECK M058F

TV

PIGMY

AVIU

J2

J4

J6

J1

J5

J3
J7

VIDEO
HI

HI–Z AVIU Adapter Cable Mini–Cam Extension CableMini-Cam On-Orbit Cable

Batt

V10

MD ASC V10 Video Cable

jsc48038_128_135r1.cvx

Pwr
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MINI-CAM (Continued) 

ENTRY VIDEO SETUP (Continued) 

 1. Remove “Entry” Ziplock bag from DTV Bag 
 

 2. Config Mini-Cam,VTR for Audio,Video Recording 
Config H/W per dwgs, FS 2-22 and FS 2-23 

 
 a. Config HUD Mini-Cam w/12mm Lens 

HUD  Using two (2) captive screws, attach HUD Brkt to installation holes for protective cover w/HUD Brkt tab pointing up 
 Brkt/Cam 

Attach Tie Wrap thru holes on captive screws to prevent screw from coming loose; cut off extra length on Tie Wrap 
 

Attach Mini-Cam Extension Cable to Mini-Cam 
 

12mm Lens  Focus – ∞ 
Aperture – f/5.6 

 
Velcro Mini-Cam w/12mm Lens to HUD Brkt.  (Top of black Velcro on front of Camr should be at top edge of HUD Brkt.  
Only yellow Velcro should be visible above HUD Brkt) 

 
 b. Config in-cabin and MD Mini-Cam w/3.5mm Lens 
 

3.5mm Lens  Aperture – f/1.8 
 
 c. Config additional Mini-Cam H/W 
 

L10:A1  AVIU 
  SYNC/VIDEO – VIDEO 
  HI-Z/75 – HI-Z 
  PWR SELECT – HI 

 
O19,MO58F  √TV PWR – ON 

 
PS ATU  Config audio as reqd for entry audio 

 
L10 (MUX)  VTR/CC PWR – on (LED on) 
L10 (VTR)  √ON/STANDBY LED – green 
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MINI-CAM (Concluded) 

ENTRY VIDEO SETUP (Concluded) 

Acquire two (2) V10 Li-ION batts 
 

NOTE 
One Batt will be used on V10 for system c/o.  Second Batt is 
spare.  Batts will be removed after c/o and used for Entry 

 
V10 (FD,MD) Install fresh Batt 

Install fresh tape in MD V10 w/MD Camera view 
PWR – ON 

√HUD 12mm Lens/Mini-Cam producing good video 
 

Change config to in-cabin 3.5mm Lens/Mini-Cam 
√In-cabin 3.5mm Lens/Mini-Cam producing good video 
√MD Camera view 

 
PWR – OFF 

 
L10 (VTR) ON/STANDBY pb – push (red LED off) 
L10 (MUX) VTR/CC PWR – off (LED off) 

 
O19,MO58F TV PWR – OFF 

 
NOTE 

TV,VTR pwr will be re-enabled per ENT AFT FLT DECK 
CONFIG  15  (DEORB, NOMINAL DEORBIT PREP); recording 
will be initiated via ENTRY C/L 

 
Start w/3.5mm Lens/Mini-Cam video in-cabin and reconfig for 12mm Lens/Mini-Cam when exterior scene available 

 
When exterior avail: 

Focus – Adjust per V10 
Aperture – Adjust per V10 
If needed, turn down brightness on HUD display 

 
Turn off V10 when not needed 
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LASER CAMR SYSTEM (LCS)/INTEGRATED SENSOR INSPECTION SYSTEM DIGITAL CAMR (IDC) 

LCS/IDC (HEATER ONLY MODE)/(OPERATIONAL PWR MODE) DATA AND PWR INTERFACES 

 

  LCS/IDC       

CNTL
BUS
AB2

Conv

Output

28V

Converter 124V

MCC
LCS Ground

Analysis
Station

MNA

APCU 1

Ku-Band,
TDRS, &
Ground
Stations

PGSC Lan
OCA &

KFX
PGSCs

LCC
(A31p)

OPP to LCC Cable (20 ft)

LCH

Power PC

Ethernet
Switch

124 V DC
Operate
power

OPP

SPDU

SRMS

IBA

jsc48038_128_134c.cvx
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Output
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APCU 2

124V

Thermister

124V Heater

IDC

A15

MNB

CNTL
BUS
CA1

124V Heater

PTU/MAIN BUS A

PTU/MAIN BUS B*

*See PTU 2/MAIN BUS B for detailed system dwg

Converter

ROEU

MLPM
Interconnect

bus
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LASER CAMR SYSTEM (LCS)/INTEGRATED SENSOR INSPECTION SYSTEM DIGITAL CAMR (IDC) (Concluded) 

PTU 2/MAIN BUS B SYSTEM DETAILS 

 
 

MNB

ESS2CA

MNB
CONTR

O13

jsc48037_PTU2_134e.cvx

A15

MNC

MNB
CONTR

O15
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OFF

PTU 2
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PTU 2
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OTHER

SYSTEMS
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TO BE CONVERTED

BY APCU 2
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CUE CARD CONFIGURATION 
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 TV 
ACTIVATION  
A3 MON 1(2) PWR – ON (LED ON) 
A7 √TV DNLK – ENA 

TV PWR CONTR UNIT – MNA(B) 
TV PWR CNTL – PNL, wait 10 sec for system initialization, CMD 

 

OPERATION 
 

Auto Ops (Auto Exposure) 
 √MCC has commanded sync config 
A7 TV CAMR PWR A(B,C,D,RMS) – ON (tb-ON) 

VID OUT MON 1(2) pb – push 
VID IN pb – as reqd 
If CTVC: 

ALC pb – push 
AVG pb – push 

If ITVC: 
If MAN GAIN pb not illuminated: 

TV CAMR PWR A(B,C,D,RMS) – OFF, wait 10 sec, ON 
Repeat until MAN GAIN pb illuminated 

LT LEVEL pb – push 
DAY(NIGHT) pb – push 
ALC pb – push 
AVG pb – push 

 
Dnlk Ops 

Coordinate dnlk and sync config w/MCC 
Config audio as reqd 

 
If analog, on MCC GO: 

A7  VID OUT DNLK pb – push 
VID IN pb – as reqd 

If DTV, on MCC GO: 
L10  √Cables connected 
 (MUX)  MUX/VTR/CC PWR – on (LED on) 

√MUX BYPASS – ACT 
 (VIP)  PWR – on (LED on, DATA FLOW LED flashes twice) 
 (VTR)  √ON/STANDBY LED – green 

√INPUT SELECT – VIDEO 
A7  VID OUT DTV pb – push 

VID IN pb – as reqd 
L10 
 (VIP)  √DATA FLOW LED – on 
 (MUX)  √CHANNEL 3 DATA LED – on 

DEACTIVATION 

Manual Ops – CTVC/ITVC (Manual Exposure) 
CAUTION 

DO NOT LEAVE CAMRS UNATTENDED IN MANUAL 
MODE.  DIRECT SUNLIGHT WILL DAMAGE CAMRS  

Manual Exposure ON 
A7 MAN GAIN pb – push 

0(+12,+24) dB pb – push 
CAMR CMD IRIS – OP,CL  

Return to Auto Exposure 
ALC pb – push 
AVG pb – push 

 
MUX Ops 

NOTE 
Although dnlk/rcd is in color, MON 
will display MUX in B&W  

A7 VID OUT MON pb – as reqd 
VID IN MUX 1(2) pb – push 
VID OUT MUX 1(2) L pb – push 
VID IN pb – As reqd 
VID OUT MUX 1(2) R pb – push 
VID IN pb – as reqd 

 
For RSC ops: 

Go to LDRI/ITVC Cue Card 
 
Keel Camr 
L12 √cb SW PWR 3 – cl 
 (SSP 2B) 
 √MPLM KEEL CAM HTR/ILLUM PWR – ON 

MPLM KEEL CAM PWR – ON 

If Illuminator ON: 
Refer to Illuminator Ops and perform Illuminator OFF 

 
A7 PORT RMS CAMR – WRIST 

TV CAMR PWR A(B,C,D,RMS) – OFF (tb-OFF), wait 10 sec 
PORT RMS CAMR – ELBOW 
TV CAMR PWR RMS – ON (tb-on), wait 10 sec, OFF (tb-OFF) 
If Keel: 

L12  MPLM KEEL CAM PWR – OFF 
 (SSP 2B)  MPLM KEEL CAM √HTR/ILLUM PWR – ON 
A7 TV PWR CNTL – PNL 

TV PWR CONTR UNIT – OFF 
TV PWR CNTL – CMD 

A3 MON 1,2 PWR – OFF 

 
If DTV: 

L10 
  (VTR)  ON/STANDBY pb – push (red LED on) 
  (VIP)  PWR – off (LED off) 
  (MUX)  MUX/VTR/CC PWR – off (LED off) 

VTR/CC PWR – off (LED off) 

 

 P/TV-1a/128/O/B
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Illuminator Ops 

Illuminator ON 
If MPLM Keel Illuminator: 

L12  √cb CB2 – cl 
(SSP 2B)  √MPLM KEEL CAM PWR – ON 
  MPLM KEEL CAM HTR/ILLUM PWR – OFF,ON for  
     HI (repeat for MED,LOW,OFF) 

If Wrist Illuminator: 
R14:D(E)  √cb TV RMS CAMR/PTU – cl 

cb TV RMS √WRIST ILLUM/CAMR HTR – cl 
√cb TV RMS WRIST ILLUM/CAMR HTR – op,cl 

If Elbow Illuminator 
√cb TV RMS CAMR/PTU – cl 
cb TV RMS √ELB ILLUM/PTU HTR – cl 
√cb TV RMS ELB ILLUM/PTU HTR – op,cl 

If A(B,C,D,ELB) Illuminator: 
√cb TV A(B,C,D,RMS,ELB) CAMR/PTU – cl 
cb TV A(B,C,D,RMS,ELB) √ILLUM/PTU HTR – cl 
√cb TV A(B,C,D,RMS,ELB) ILLUM/PTU HTR – op,cl 

 
Illuminator OFF 

If MPLM Keel Illuminator: 
L12  MPLM KEEL CAM HTR/ILLUM PWR – toggle until  
 (SSP 2B)   Illuminator OFF (leave sw in ON posn) 

If Wrist Illuminator: 
R14:D(E)  cb TV RMS WRIST ILLUM/CAMR HTR – op,cl 

If Elbow Illuminator: 
cb TV RMS ELB ILLUM/PTU HTR – op,cl 

If A(B,C,D) Illuminator: 
cb TV A(B,C,D) ILLUM/PTU HTR – op,cl 

If RSC Illuminator: 
Go to LDRI/ITVC (Cue Card) 

 

jsc48037_128_011.cvx
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ANALOG PLAYBACK 
ANALOG VIA CC ANALOG VIA VTR 

NOTE  
Analog Playback from CC only possible for CC Video recordings  
ACTIVATION ACTIVATION 
CC Setup per diagram (back of cue card) 
A7 Perform ACTIVATION (Cue Card, TV), as reqd 
O19 √TV PWR – ON 
 
AVIU SYNC/VIDEO – VIDEO 

HI-Z/75 – 75 
PWR SELECT – LO 

 
CC PWR – VTR/PLAY 

√A/V1/V2 – V2 
 

Setup per diagram (back of cue card) 
Disconnect CC Video input from AVIU J3 
Perform ACTIVATION (Cue Card, TV) as reqd 

O19 √TV PWR – ON 
 
AVIU SYNC/VIDEO – VIDEO 

HI-Z/75 – 75 
PWR SELECT – LO 

L10 
 (MUX) √VTR/CC PWR – on (LED on) 
 (VTR) √ON/STANDBY LED – green 

 
OPERATIONS OPERATIONS 

PLBK or DNLK VIDEO PLBK or DNLK VIDEO 

CC Install tape, if reqd 
 

If audio reqd: 
CCU  If MHA, COMM PWR – ON 
ATU  PWR – AUD 

Desired Loops – T/R 
Other Loops – RCV(OFF) 
XMIT/ICOM Mode – VOX/VOX 
VOX SENS – MAX 

 
CC  Speaker Vol Max 
 
A7 VID OUT MON pb – as reqd 

VID IN FLT DECK(MIDDECK) pb – push 
CC VTR pb – REW(FF) to cue tape 
 
If Dnlk 

√MCC has commanded async config 
A7 √TV DNLK – ENA 

VID OUT DNLK pb – push 
VID IN FLT DECK(MIDDECK) pb – push 

 
CC PLAY pb – push (green  displayed) 
 

If PLBK(DNLK) complete: 
STOP pb – push 

If CC ops complete, go to DEACTIVATION 
 

L10 (VTR) Install tape if reqd 
 √DISPLAY SELECT – DATA 
 

If audio reqd: 
L10 (VIP)  PWR – on (LED on, DATA FLOW LED 

flashes twice) 
ATU – PBK/KEY MIC (Amber LED on) 

CCU  If MHA, COMM PWR – ON 
ATU  PWR – AUD 

Desired Loops – T/R 
Other Loops – OFF 
XMIT/ICOM Mode – VOX/VOX 
VOX SENS – MAX 

 
A7 VID OUT Desired MON pb – push 

VID IN FLT DECK pb – push 
L10 (VTR) REW(FF),PLAY,PAUSE pb – push as reqd to 

cue tape 
 
If Dnlk 

√MCC has commanded async config 
A7 √TV DNLK – ENA 

VID OUT DNLK pb – push 
VID IN FLT DECK pb – push 

 
L10 (VTR) PLAY pb – push (green • displayed) 
 

If PLBK(DNLK) complete: 
STOP pb – push 

If VTR ops complete, go to DEACTIVATION 
 

DEACTIVATION DEACTIVATION 
CC Remove, mark, stow tape as reqd 

PWR – OFF 
ATU Reconfig as desired 
O19 TV PWR – OFF, as reqd 

Go to DEACTIVATION (Cue Card, TV), as reqd 
 

 Connect CC video input to AVIU J3 
L10 (VTR) Remove, mark, stow tape as reqd 
ATU Reconfig as desired 
O19 TV PWR – OFF, as reqd 

Go to DEACTIVATION (Cue Card, TV) as reqd 
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ANALOG VIA CC PLAYBACK 

 

ANALOG VIA VTR PLAYBACK 
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P/TV-3a/128/O/B

ET PHOTO 
D2Xs  D2Xs 

 
LENS SETTINGS: 

 
√APERTURE – MIN, LOCKED 
√LENS FOCUS MODE – A 

 
CAMR SETTINGS 

 
PWR – ON 
TOP LCD: 
√BATT 
√EXP MODE – M 
√SS – 1000 
√F/STOP – 8 

 
DIOPTER – ADJUST 
√FRAME RATE – S 
√BODY FOCUS MODE-S 

 
REAR LCD: 
√ISO – 100 
√QUAL – RAW 

 
CRITICAL FOCUS REQD EACH FRAME

TOP 
BACK OF ‘ET PHOTO’ 

P/TV-3b/128/O/A

HOOK 
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ET PHOTO 
G1 CC  G1 CC 

 
LENS CAP – REMOVE 
INSTALL MUTING PLUG 

 
√ND FILTER – OFF 
√AF/M – M 
√AGC – OFF 
√GAIN – L 
√OUTPUT – CAM 
√AWB – ON 
√POWER dial – M 
√LOCK (handle) – off (aft) 
STANDBY/LOCK – STANDBY 

 
OPEN LCD 
√BATT SUFFICIENT 
√EXP MODE – M 
√SS – 1/1000 
√GAIN – ±0dB 
√F/STOP – F8.0 
√FOCUS MODE – MF ∞– 

 
ZOOM – WIDE TO FIND TANK, THEN TIGHT 

 
START RECORDING 

 
√LCD DISPLAYS RED DOT 
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CAMR ADJUSTMENTS ANTENNA LOCATIONS 
ADJUST BRIGHTNESS 

Course Adjustment 
PGSC Select Page – RF Camera 

Lens Iris Control – cl(op) 
 

Fine Adjustment 
PGSC Select Page – RF Camera 

Electronic Shutter – Manual 
Brightness – Dec(Inc) 

(# to right:  100 = brightest; 0 = darkest) 
 
DARK SUBJECT 

PGSC Select Page – RF Camera 
√Advanced Controls displayed 

Automatic Gain Control – Enabled 
(Disabled preferred) 

 
PWRDN 

For all lens (three) on each RF Camera Assy: 
PGSC Lens Iris Control – Close until view black 
 

Sel RF Camr 1,2 – None (black “OFF”) 
V10 √Test Pattern displayed (color bars w/“No WVS 

Video”) 
PGSC Select Page – XCVR 

Transceiver 1(2) CMD Pwr – Off 
(black CMD PWR:LVL-“OFF:Min”) 

Sel File → Exit 
 
V10 STOP pb – push 

Mark,stow tapes 
PWR – OFF 

 
A7 WIRELESS VID PWR – OFF 
  WIRELESS VID HTR – OFF 
 

VIDEO SIGNAL PROBLEMS 

 For problem EMU TV: 
EMU EMU TV Pwr pb – push (no LED), wait 10 sec, push 

              (green LED) 
 
 If no joy: 
PGSC √Select Page – XCVR 
  √Advanced Controls displayed 

For XCVR w/Video problem:  IF – Narrow 
 
 If still no joy: 
A7 WIRELESS VID PWR – OFF, wait 10 sec, ON 
 
 If still no joy: 
PGSC For XCVR w/video problem:  IF – Wide 

For XCVR w/good video:  Sel RF Camr – None (black ‘OFF’) 
If video acceptable, other EMU TV interfering w/signal 
Alternately sel EMU TVs to acquire video 

 
 If still no joy: 

For XCVR with good video: 
Sel RF Camr – reselect original EVA crewmember 

For XCVR w/video problem:  Antenna – Manual 
Sel desired antenna 

 
 If still no joy: 

For XCVR w/video problem:  Antenna – Auto 
√MCC 

 
COMMANDING PROBLEM (UHF) 

If commanding of WVS not visually seen: 
PGSC Select Page – XCVR 

Sel Transceiver 2(1) CMD Pwr – On 
(green CMD PWR:LVL-“ON:Min”) 

jsc48038_128_022r1.cvx
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STATIC XCVR 
Condition: No comm between PGSC & PLB XCVR  
PGSC 1. √Cable connections between WIB and PGSC  
A7 2. WIRELESS VID PWR – OFF, wait 10 sec, ON  

If no joy: 
PGSC 3. Sel ‘Start’ > ‘Shut Down’ > ‘Restart’’ > ‘OK’ 

When reboot complete: 
Sel Shuttle Apps icon > WVS icon 
Sel ‘Yes’ at ‘Restore To Previous Settings’ window 
RF Camera page will appear  

If still no joy: 
 4. √MCC  
STATIC RF CAMERA 
Condition: No telemetry and video received by PLB XCVR from EMU TV  
EMU 1. √EMU TV Pwr pb pushed (green LED)  

If no joy: 
PGSC 2. √Correct RF Camera selected via pulldown menu 

√RF Camera (two) – ON (green “ON”) 
If not ON: 

RF Camera (of static EMU TV) – sel “None” via 
pulldown menu, then sel original EMU TV  

If still no joy: 
 3. RF Camera 1(2) – sel ‘None’ 

Perform CAMR ID ASSIGNMENT 
Reattempt RF Camr selections  

If still no joy: 
 4. √CMD PWR:LVL – green “ON:Min” for XCVR 1(2) 

If not ON, 
 Select Page – XCVR 
 Transceiver 1(2) CMD Power – On  

  (green CMD PWR:LVL - “ON:Min”)  
If still no joy: 

EMU 5. EMU TV Pwr pb (of static EMU TV) – push (no LED),  
wait 10 sec, push (green LED)  

If still no joy: 
6. √MCC 

BAD CAMERA ID 
Condition: Mismatch between EMU TV Camera ID and software camera ID  
PGSC 1. Select Page – XCVR: 

Transceiver 1(2) CMD Power – On (green CMD PWR:LVL - “ON:Min”) 
Sel RF Camera 1,2 – None 
Sel File > Assign Camera ID 

√Camera IDs match data under CAMR ID ASSIGNMENT 
If not a match, 
 Highlight entry, then sel ‘Delete Entry’ option 
 Perform CAMR ID ASSIGNMENT 
 Sel RF Camera 1,2 – EVA crewmembers  

If still no joy: 
 2. √MCC  
TEMP ALERT (blue text) 
Condition: EMU TV -35 °C to -30 °C  OR  80 °C to 85 °C range 
 PLB XCVR -40 °C to -35 °C  OR  80 °C to 85 °C range  

Select Page – Telemetry 
Identify component w/temperature alert (blue text) 

√MCC  
TEMP CAUTION (yellow text) 
Condition: EMU TV < -35 °C  OR  > 85 °C 
 PLB XCVR < -40 °C  OR  > 85 °C  

Select Page – Telemetry 
Identify component w/temperature alert (yellow text) 

√MCC 

 

CAMR ID ASSIGNMENT 
Sel File → Assign Camr ID 

√All EV crewmembers listed as options on pulldown ‘Label’ menu under CAMERA ID SETUP  
If label entry reqd: 

Type label into space next to “Add Label” icon 
Sel “Add Label” icon to add to listing  

Under CAMERA ID SETUP: 
Camera Address – As reqd via left/right arrows 
Serial Number – As reqd via left/right arrows 
Label – As reqd via pulldown menu 
“In Use” Box – Check via single click 
Sel “Save Entry” icon to right of Camr ID table (top) 
√Data entry visible in Camr ID table  

Sel OK P/TV-5b/128/O/A

Camr ID Data 
Camr Address 16 18 
Serial Number 1010 1007 
Label EV1 EV2 
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PLBD VTR RECORDING 
 
L10 √VIP,VTR covers removed 
 
R1 √PL AUX – ON 
 
MA73C:E cb AC2 PL3Φ – cl 
 

√Cables config’d per dwg (back of cue card) 
L10 
 (MUX) VTR/CC PWR – on (LED on) 
 
 (VIP) √ATU – REC 

√CCTV VIDEO IN – J3 
PWR – on (LED on, DATA FLOW flashes twice) 

 
 (VTR) √ON/STANDBY LED – green 
 

√Switches set to white dot (seven) 
 

√COUNTER SELECT – COUNTER (TC) 
 

√Tape installed (tape icon LED on) 
 

Set GMT: 
DISPLAY SELECT – MENU 
↓ pb – ETC, EXEC pb – push 
↓pb – CLOCK SET, EXEC pb - push 
Use ↓, ↑,EXEC to set Y,M,D,hr,min to GMT 
DISPLAY SELECT – DATA 

 
If Audio desired: 

L9   PS AUD PWR – AUD 
Desired Loops – RCV, Vol tw 5 
Other Loops – OFF 

 
A7 VID OUT DTV pb – push 

VID IN pb – as reqd 
 
L10 
 (VTR) REC pb – push, hold 

PLAY pb – push, simo (red dot displayed) 
 

TOP 
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ACTIVATION 

1. Config CCTV Sys 
A7 √ACTIVATION (Cue Card, TV) performed 
L10 (MUX) √MUX/VTR/CC PWR – on (LED on) 

√Cabling from VTR MON port to MON 2 
C-IN 

R12 (VPU) √VPU PWR – ON (LED on) 
√Green Jumper – LDRI/ITVC 
√RSC vid cable connected to 

WIB CCTV PL/3 
MON 1,2 L-DATA – ON 
 C-DATA – GRN 
 X-HAIR – GRN 

 
MON 2 SOURCE – C 

 
2. Apply SPEE Pwr 

R12 (OPP) √cb OBSS SW PWR – cl 
√OBSS SW PWR – ON 

R12 (OBSS) SPEE PWR – ON 
A6U EVENT TIMER CNTL – STOP 
 EVENT TIMER – RESET 
 EVENT TIMER CNTL – START  

(15 min LDRI calibration warmup) 
 
3. Config RSC Illum to HI 

A7 VID OUT MON 1 pb – push 
VID IN C pb – push 

 PAN/TILT – Adjust to see RSC Camr 
R12 (OBSS) SPEE PWR – OFF, wait 10 sec, ON  
MON 1 √RSC illum on HI (three rings) 

 
4. Enable ITVC 

√MCC has commanded sync config 
R12 (OBSS) ITVC ENA – ON 
A7 VID OUT DTV pb – push 

VID IN PL 2(VPU) pb – push 
If MAN GAIN pb not illuminated: 

R12 (OBSS) ITVC ENA – OFF, wait 10 sec, ON 
Repeat until MAN GAIN pb 

illuminated 
A7 LT LEVEL pb – push 

DAY (NIGHT) pb – push 
ALC pb – push 
AVG pb – push 

MON 2 √ITVC video displayed 
 
5. Turn LDRI Laser On 

A7 VID OUT MUX 1 L pb – push 
VID IN MIDDECK pb – push 
LDRI MODE 2 pb – push 

 VID OUT DTV pb – push, to return to 
ITVC control 

GENERAL LDRI CONTROL 

A7 VID OUT MUX 1 L pb – push 
VID IN MIDDECK pb – push 

 
Mode 1 (default at pwrup) 
A7 LDRI MODE 1 pb – push 
MON 2 √ITVC video displayed 
 
Mode 2 
A7 LDRI MODE 2 pb – push 
MON 2 √ITVC video w/illum displayed 
 
Modes 3 (4,5,6) 
A7 LDRI MODE 3(4,5,6) pb – push 
MON 2 √LDRI w/rounded corners displayed 

To adjust brightness: 
A7 CAMR CMD IRIS – OP,CL, as reqd 
 
PAN/TILT OPS WITH LDRI ACTIVE 

NOTE 
When adjusting pan/tilt in Modes 
3(4,5,6), ITVC FOCUS (ZOOM, 
IRIS) cntls functional 

 
A7 VID OUT MON 1 pb – push 
 VID IN PL2(VPU) pb – push 

CAMR CMD PAN,TILT – as reqd 
VID OUT MUX 1 L pb – push, to return to LDRI cntl 

DEACTIVATION 

A7 VID OUT MUX 1 L pb – push 
VD√IN MIDDECK pb – lt on 
LDRI MODE 1 pb – push 

 
R12 (OBSS) ITVC ENA – OFF, pause 10 sec 

SPEE PWR – OFF 
A6U EVENT TIMER MODE – UP 
 EVENT TIMER CNTL – START 
 
 
 

LDRI MODE SUMMARY 

Mode 1 – Standby 
• ITVC video 
• LDRI in standby 
 
Mode 2 – Illuminator 
• ITVC video w/illum 
• LDRI laser active, LDRI camera  

inactive 
 
Mode 3 – 2D 
• LDRI 2D video 
• Similar to ITVC video 
 
Mode 4 – 2D Gamma 
• LDRI 2D video w/Gamma Black 

Stretch 
• Similar to ITVC video 
 
Mode 5 – 3D 
• LDRI 3D video 
• Flicker on MON 
 
Mode 6 – 3D Gamma 
• LDRI 3D video w/Gamma Black 

Stretch 
• Flicker on MON 
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RSC CAMR OPS 

NOTE 
Camr nominally pwrd in Block 3 of PI C/L 

 
R12 (OPP) cb OBSS SW PWR CB1 – cl 

OBSS SW PWR – ON 
R12 (OBSS) RSC PWR – ON 
 
RSC ILLUMINATOR OPS 

NOTE 
RSC illuminator OFF when SPEE PWR 
sw initially taken to ON.  A cycle of the 
SPEE PWR sw takes RSC illuminator to 
HIGH.  Subsequent pwr cycles take 
illuminator to MED, LOW, OFF and then 
back to HIGH.  Config may req alt Camr 
view of RSC 

 
R12 (OBSS) √SPEE PWR – ON 

√RSC PWR – ON 
ITVC ENA – OFF 

A7 VID OUT MON 1 pb – push 
VID IN A(B,C,D) pb – push 
PAN,TILT – Adjust to see RSC Camr 

 
NOTE 

SPEE pwr cycle will reset LDRI/ITVC to 
Mode 1 and reset the PTU angles 

 
R12 (OBSS) SPEE PWR – OFF, wait 10 sec, ON 
MON 1 √RSC illum on 
 

To cycle thru illuminator modes: 
R12 (OBSS)   SPEE PWR – OFF, wait 10 sec, ON 
 

Perform LDRI/ITVC ACTIVATION, step 4 
 

Return to original LDRI/ITVC Mode, continue 
OPS 

 

CONTINGENCY LDRI CLEARANCE VIEW 

NOTE 
Do not apply RMS brakes 

 
A8U AUTO SEQ – STOP (READY lt on) 
 
L10(VTR) STOP pb – push (no red •) 
 
A7 VID OUT MUX 1 L pb – push (MIDDECK lt on) 
 LDRI MODE 3(4) pb – push (steady LDRI video) 
 
 VID OUT MON 1 pb – push 
 VID IN PL2(VPU) pb – push 
 
 Record PTU Pan _________ and Tilt _________ 
 
 CAMR CMD PAN/TILT – HI RATE  
 CAMR CMD PAN:  0 (left, to hard stop) 
 CAMR CMD TILT:  0 (up, to hard stop) 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 Note clearance thru LDRI FOV 
 
 Return PTU to Pan and Tilt values recorded above 
 
 VID OUT MUX 1 L pb – push (MIDDECK lt on) 
 LDRI MODE 6 pb – push (flickering LDRI video) 
 
 VID OUT MON 1 pb – push 
 VID IN pb – as desired (not PL2) 
 
L10(VTR) REC pb – push, hold 
 PLAY pb – push, simo (red dot) 
 
A8U AUTO SEQ – PROCEED (IN PROG lt on) 
 

LDRI PAN/TILT RESET 

Reset PTU 
A7 VID OUT MON 1 pb – push 
 VID IN PL2(VPU) pb – push 
 
 CAMR CMD PAN/TILT – HI RATE 
 CAMR CMD PAN – L (to hard stop) 
 CAMR CMD TILT – UP (to hard stop) 
 CAMR CMD PAN/TILT – RESET 
 
SPEE PWR DEACT CLEANUP ACTIONS 

Config RSC Illum to HI 
R12 (OBSS) √SPEE PWR – OFF 
 ITVC ENA – OFF 
 RSC PWR – OFF, wait 10 sec, ON 
 SPEE PWR – ON, OFF, wait 10 sec, ON 
 
Config ITVC 
 ITVC ENA – ON 
A7  VID OUT DTV pb – push 
 VID IN PL2(VPU) pb – push 
 If MAN GAIN pb not illuminated: 
R12 (OBSS)    ITVC ENA – OFF, wait 10 sec, ON 
    Repeat until MAN GAIN pb illuminated 
A7 LT LEVEL pb – push 
 DAY (NIGHT) pb – push 
 ALC pb – push 
 AVG pb – push 
 
Reset PTU 
A7 CAMR CMD PAN/TILT – HI RATE 
 CAMR CMD PAN – L (to hard stop) 
 CAMR CMD TILT – UP (to hard stop) 
 CAMR CMD PAN/TILT – RESET 
 PAN and TILT ITVC to values needed for 

Survey 
 
Return LDRI to Mode 6 
A7  VID OUT MUX 1 L pb – push 
 VID IN MIDDECK pb – push 
 LDRI MODE 6 pb – push 
 VID OUT DTV pb – push, to return to ITVC 

control 
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LCH ACTIVATION 
 Activate SSPTS APCU 2 
A15 √PTU 2 tb – on 
 APCU 2 OUTPUT – ON 
 APCU 2 CONV – ON 
 
  SM 179 POWER TRANSFER  
 √PTU 2 APCU OUT VOLTS:  123V to 126V 
 PTU 2 APCU √OUTPUT – ON 
 
LCC ACTIVATION 
1. LCC Setup 

 √Hardware and cables configured per diagram below: 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
2. LCC Startup 

A31p √PGSC Pwr – ON 
 √Yellow ‘RJ-45 Port Configured for LCS Ops’ displayed on desktop crew 

patch 
 If yellow text not displayed, perform TROUBLESHOOTING, Yellow  

‘RJ-45 Port Configured for LCS Ops’ Not Displayed on Desktop Crew 
Patch 

 If ‘LCS Camera Controller’ minimized on desktop taskbar, maximize 
window 

 If not minimized, sel ‘Shuttle Apps’ > ‘LCC’ (wait 2-3 min from APCU 
CONV – ON for GUI Status) 

 √Laser off – blue 
 √Comm – green 
 If Laser off and Comm status not correct:  √MCC 

 
3. Verify LCC Desktop Video 

MO58F √TV PWR – ON 
AVIU √HI-Z/75 – 75 
 PWR SELECT – LO 
CC PWR – OFF 

3. Verify LCC Desktop Video (Concluded) 
A31p Minimize all programs 
 Right click on ATI icon on system tray 
 Sel ‘Schemes’ 
 Sel ‘ENABLE DESKTOP DOWNLINK’, ‘ATI Property Page’ displayed 
 Sel ‘Yes’ 
 Maximize program windows as desired 

 
A7 VID OUT MON1(2) pb – push 
 VID IN MIDDECK pb – push 
A3 √LCC desktop displayed on MON1(2) 

 
* 
* 

If LCC Desktop not displayed 
√MCC  

*
*

 
4. Verify GMT 

A31p √GMT on GUI lower right-hand side within 3 sec of SM-GPC GMT  
* 
* 
* 

If GMT not within 3 sec of SM GPC:
Sel ‘Tools’ > ‘Set GMT’  
Adjust GMT as reqd 
Sel ‘Apply’ > ‘OK’ 

*
*
*
 

OPERATION 
NOTE 

PDRS OPS will call for appropriate scan steps on LCC.  
MCC may have limited insight if desktop dnlk avail 

 
1. Load Database (if reqd) 

 √MCC for desired LCS database 
 √‘DB Name’:  Field on upper left-hand side of LCS GUI  

* 
* 
* 

If ‘DB Name’ incorrect: 
Sel ‘Load Database…’ from File menu 
Sel MCC desired database file 
Sel ‘OK’ 

*
*
*

 
2. LCS System Status 
 

LCS SYSTEM STATUS 
Laser On/Off Comm LCS State 

Laser ? (gray) No Comm 
(yellow) 

Unknown or Keep Alive Heater Only Mode 
( No LCC to LCH Network Connection) 

Laser Off (blue) Comm (green) Configuration 
(Waiting for user command) 

Laser On (green) Comm (green) Operational 
(Scan in progress) 

 
 While Scan in progress (‘Scan Status’ counter incrementing): 
 √Laser On – green 
 √Comm – green 
 √Scan Display – updating 
 √Temp – green 
 √Elec – green 
 Scan complete when ‘Scan Status: Complete’ displayed  
 If LCS system status out of config, perform appropriate 

TROUBLESHOOTING section of this cue card 

 
P/TV-8a/128/O/A

LCS 

(For SSPTS APCU 2 flights only) 

 

(reduced copy) 



 FS CC 3-15 P/TV/128/FIN 
FS CC 3 17 (FQ)

TOP 
BACK OF ‘LCS’ 

HOOK 
VELCRO 

HOOK 
VELCRO 

 

LCC DEACTIVATION 

NOTE 
Shutting down LCC software also puts LCH in 
keep-alive heater mode.  No LCH scans/insight or 
IDC ops available.  APCU Converter pwr cycle 
reqd to reinitialize LCH for scanning and IDC ops 

 
1. LCC Software Shutdown 

A31p Sel ‘File’ > ‘Exit’ 
 When 'Shutdown' dialog box opens: 
 √'Shutdown LCH and Exit LCC Software' selected 
 Sel 'OK' 
 When 'Shutdown?' dialog box opens: 
 Sel 'OK' 

 
2. A31p Screen Resolution Reset 

  
A31p Right click on ATI icon on system tray 
 Sel ‘Schemes’ 
 Sel ‘DISABLE DESKTOP DOWNLINK, ATI Property Settings’ 
 Sel ‘Yes’ 
 Arrange program windows as desired 

LCH DEACTIVATION 

CAUTION 
Deactivating SSPTS APCU 2 will remove 
critical keep-alive pwr to LCH and IDC.  
Pwr must be reapplied within 105 min 

 
1. Deactivate SSPTS APCU 2/LCH 
 

A15 APCU 2 CONV – OFF 
 

  SM 179 POWER TRANSFER  
 √PTU 2 APCU OUT VOLTS:  <10V 

 
 APCU 2 OUTPUT – OFF 

TROUBLESHOOTING 

Temp or Elec Status Yellow  
A31p Sel ‘System’ page 
 Report ‘Elec’ or ‘Temp’ values backlit in yellow to MCC  
 
Comm Status Yellow and LAN2 Network cable unplugged (red X on A31p system tray) 
 

NOTE 
LCC GUI Comm status will be yellow and A31p Local Area Network 
status (w/red X on A31p system tray) cable unplugged tool tip will 
appear if LCH is in keep-alive heater mode 

 
A31p If unexpected red X w/Local Area Network Connection tool tip shown on A31p 

system tray: 
 
 
 
 
 
 
R12 √OPP to LCC Cable connected to LCS CMD/TLM(J107) port 
A31p √OPP to LCC Cable connected to LCC RJ45 port 
 Exit LCC software and shut down Windows 
 
A15 APCU 2 CONV – OFF 
 APCU 2 OUTPUT – OFF, wait 10 sec, ON 
 APCU 2 CONV – ON 
APCU 2  
  SM 179 POWER TRANSFER  
 √PTU 2 APCU OUT VOLTS: 123V to 126V 
 
A31p LCC PGSC Pwr – ON 
 √A31p internal RJ45 Network Interface Card LED green 
 Perform LCC ACTIVATION, step 2 
 
 √Local Area Network Connection status icon (with red X) in Windows system 

tray not displayed 
 √MCC if LCC GUI Comm status still yellow 
 
Message Area Entry 
 Report LCC GUI message area log entry(ies) to MCC 
 
Yellow  ‘RJ-45 Port Configured for LCS Ops’ Not Displayed on Desktop Crew Patch 
A31p Sel ‘Shuttle Apps’ > ‘Network Configuration’ > ‘LCS RJ-45 Network Setup’ 
 Enter ‘1’ in network window 
 Sel ‘OK’ 
 Sel ‘OK’ in LCS window 
 Allow 20 sec for program to execute 
 √Yellow text displayed on desktop 
 Resume LCS Ops  

P/TV-8b/128/O/A
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IDC ACTIVATION 

1. LCC Setup 
 √Hardware configured per LCC ACTIVATION steps 1,2 (Cue Card, LCS) 

 
A31p √PGSC Pwr – ON 

 
2  IDC connectivity Check 

A31p √A31p internal RJ45 Network Interface Card LED green 
 If RJ45 Network Interface Card LED not green: 
A15 APCU 2 CONV – OFF 
 APCU 2 OUTPUT – OFF, wait 10 sec, ON 
 APCU 2 CONV – ON 

 
  SM 179 POWER TRANSFER  
 √PTU 2 APCU OUT VOLTS:  123V to 126V 

IDC SOFTWARE ACTIVATION 

1. IDC Software Startup 
A31p Sel ‘Shuttle Apps’ > ‘IDC’ 

 
2. Verify GMT 

A31p √GMT within 3 sec of SM-GPC GMT 
 

* 
* 
* 
* 

If GMT not within 3 sec: 
Double click on GMT box on GUI 
Adjust GMT as reqd 
Sel ‘OK’ on MTU Time dialogue box 

*
*
*
*

 
3. IDC Pwr on and self test 
 

CAUTION 
Pwr off IDC when not imaging.  Pointing IDC at Sun when 
pwr on will damage Camr 

 
A31p Sel ‘Power On’ 

 
 √Black and White self-test image displayed 
 √‘Waiting for User Command’ displayed 

 
* 
*
* 

If red backlit error msg displayed: 
Perform appropriate TROUBLESHOOTING 

steps on this cue card 

*
*
* 

OPERATION 

NOTE 
PDRS OPS will call for IDC image steps on LCC A31p.  Limited 
MCC real-time insight avail if configured for desktop dnlk 

 
1. Configure LDRI Illumination 

R12 (VPU) √Green Jumper – LDRI/ITVC 
A7 VID OUT MUX 1L pb – push 
 VID IN MIDDECK pb – push 
 LDRI MODE 2 pb – push 
 VID OUT MON 1(2) pb – push 
 VID IN PL2 (VPU) pb – push 
 CAMR CMD PAN/TILT – HI RATE 
 CAMR CMD PAN – L (to hard stop) 
 CAMR CMD TILT – UP (to hard stop) 
 CAMR CMD PAN/TILT – RESET 
 CAMR CMD PAN/TILT – LO RATE within 10° 
 CAMR CMD PAN:  +85 (right) 
 CAMR CMD TILT:  -57 (down) 

 
NOTE 

If IDC GUI GMT does not update during Ops, an 
attempt to shut down/restart A31p should be made 

 
2. Auto Exposure (AE) Ops 

A31p √‘Use AE’ checked 
 Sel ‘Scan Lo-Res’ 
 Resize and posn AE box as reqd (pause 2 sec) 
 √MCC for AOI FOV 
 Sel ‘Scan Hi-Res’ 
 If Scanning w/no RMS Motion: 
 Sel ‘Stop Scan’ after 30 sec 
 If scanning w/RMS motion: 
 Move box to maintain RCC in AE box (using keyboard arrows) 
 Sel ‘Stop Scan’ at pause point 
 √‘Waiting for User Command’ displayed 

 
3. Scenario File Ops 

A31p From Scenario File drop-list, sel appropriate lighting condition 
 
 
 
 
 
 
 
 

 Sel ‘Acquire Set’ 
 √‘Acquiring Set’ displayed 
 √‘Waiting for User Command’ displayed after set 
 √MCC content w/data take 
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IDC DEACTIVATION 

1. IDC and Software Shutdown 
A31p Sel ‘Power off’ on IDC GUI 
 IDC software > ‘YES’ 
 Close (X) IDC software > 'YES' 

 
2. A31p Screen Resolution Reset 

A31p Right click on ATI icon on system tray 
 Sel ‘Schemes’ 
 Sel ‘DISABLE DESKTOP DOWNLINK, ATI Property Settings’ 
 Sel ‘Yes’ 
 Arrange program windows as desired 

IDC HOT KEY COMMANDS 

F5 – Toggle Summary View F6 – Toggle Image Mode 
F7 – Zoom In F8 – Zoom Out 
F9 – Reset Brightness and Contrast F10 – Reset AE Box to Default 

F11 – Toggle AE Box Visibility F12 – Find AE Box 

IDC SOFTWARE ERROR MESSAGES 

Can’t connect to LCH:  Perform TROUBLESHOOTING, steps 1,2 
Condition:  Possible heater only mode or Network failure 
 
Iport probe failed:  Perform TROUBLESHOOTING, step 2 
Condition:  Iport startup check failed 
 
Iport not responding:  Perform TROUBLESHOOTING, step 2 
Condition:  Iport connection lost 
 
Camera not responding:  Perform TROUBLESHOOTING, step 2 
Condition:  Camera connectivity lost 
 
Image acquisition failed:  Perform TROUBLESHOOTING, steps 1,2 
Condition:  Camera connectivity lost during imaging 
 
Network recovery failed:  Perform TROUBLESHOOTING, steps 1,2 
Condition:  LCH network switch connection lost 
 
Bad initialization file:  Perform TROUBLESHOOTING, step 3 
Condition:  Software will not launch due to severe ini file corruption 

TROUBLESHOOTING 

1. LCC to LCH Connectivity Check 
A31p If Local Area Network Connection (with red X) tool tip on system tray: 

 
 
 
 
 
 

 Reseat OPP to LCC Cable (20 ft) to LCC RJ45 port 
 √Local Area Network Connection Speed 10 mps 
 If no connection: 
  Perform LCH, LCC, and IDC Reset, step 2 
 Continue nominal ops 

 
2. LCH, LCC, and IDC Reset 

A31p Exit IDC software and shut down Windows 
 √OPP to LCC Cable (20 ft) connected to LCC RJ45 port and LCS 

CMD/TLM port 
 

A15 APCU 2 CONV – OFF 
 APCU 2 OUTPUT – OFF, wait 10 sec, ON 
 APCU 2 CONV – ON 

 
  SM 179 POWER TRANSFER  
 √PTU 2 APCU OUT VOLTS:  123V to 126V 

 
A31p LCC PGSC Pwr – ON 
 √A31p internal RJ45 Network Interface Card LED green 

 
 Perform IDC SOFTWARE ACTIVATION 
 Continue nominal ops 

 
3. LCC Swap 

A31p Exit IDC software and shut down Windows 
 Swap LCC with other A31p 
 Perform IDC Activation 
 Perform IDC Software Activation 
 Continue nominal ops 
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D2Xs PROGRAM 
In Cabin D2Xs Aperture Priority D2Xs Shutter Priority 

“Earth Obs” 
Lens – as reqd 
Aperture – Min, locked 
Body Focus Mode – S 

√Batt installed 
√Flash Card installed 

Pwr – ON 
Top LCD: 
√Batt 
√Frames remaining sufficient 

Exp Comp (     ) – 0.0 
Exp Mode – P 
Meter – Matrix (     ) 
Diopter – Adjust 
Frame Rate – S 

√BKT disabled – 0 F 
Rear LCD: 
√ISO – 100 
√QUAL – RAW 
√WB – 0,A 

√Focus Area – Center 
√Focus Selector Lock – L 

AF Area Mode – [ [  ] ] 
 

SB-800 Flash Settings: 
√Diffuser Dome installed 

ON/OFF pb – ON 
√MODE –                     
√Exp Comp – 0 EV 

Tilt – 45° (Direct) 
 

Lens – as reqd 
Aperture – Min, locked 
Body Focus Mode – S 

√Batt installed 
√Flash Card installed 

Pwr – ON 
Top LCD: 
√Batt 
√Frames remaining sufficient 

Exp Comp (     ) – 0.0 
Exp Mode – A: 

f/stop – as reqd 
Meter – Matrix (     ) 
Diopter – Adjust 
Frame Rate – S 

√BKT disabled – 0 F 
Rear LCD: 
√ISO – 100 
√QUAL – RAW 
√WB – 0,A 

AF Area Mode – [ [  ] ] 
√Focus Area – Center 
√Focus Selector Lock – L 

 
SB-800 Flash Settings: 
√Diffuser Dome installed 

ON/OFF pb – ON 
√MODE –                      
√Exp Comp – 0 EV 

Tilt – 45° (Direct) 
 

Lens – as reqd 
Aperture – Min, locked 
Body Focus Mode – S 

√Batt installed 
√Flash Card installed 

Pwr – ON 
Top LCD: 
√Batt 
√Frames remaining sufficient 

Exp Comp (     ) – 0.0 
Exp Mode – S: 

SS – 500 
Meter – Matrix (     ) 
Diopter – Adjust 
Frame Rate – S 

√BKT disabled – 0 F 
Rear LCD: 
√ISO – 100 
√QUAL – RAW 
√WB – 0,A 

AF Area Mode – [ [  ] ] 
√Focus Area – Center 
√Focus Selector Lock – L 

 
SB-800 Flash Settings: 

ON/OFF pb – OFF 
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TOP 
BACK OF ‘D2Xs’ 

HOOK 
VELCRO 

 

D2Xs MANUAL 
“SUNLIT OBJECTS” 

D2Xs EXPOSURE MATCH 
“HERO SHOT” D2Xs CREW PHOTO  

Lens – as reqd 
 

NOTE 
If auto focus unachievable: 

Lens Focus Mode – M 
 

Lens Focus Mode – A 
Aperture – Min, locked 
Body Focus Mode – S 

√Batt installed 
√Flash Card installed 

Pwr – ON 
Top LCD: 
√Batt 
√Frames remaining sufficient 

Exp Comp (      ) – 0.0 
Exp Mode – M: 

SS – 500 
f/stop – f/8 

Meter – Matrix (     ) 
Diopter – Adjust 
Frame Rate – S 

√BKT disabled – 0 F 
Rear LCD: 
√ISO – 100 
√QUAL – RAW 
√WB – 0,A 

AF Area Mode – [ [  ] ] 
√Focus Area – Center 
√Focus Selector Lock – L 

 
SB-800 Flash Settings: 

ON/OFF pb – OFF 

Lens – 12-24mm @ 18mm 
Aperture – Min, locked 
Body Focus Mode – S 

√Batt installed 
√Flash Card installed 

Pwr – ON 
Top LCD: 
√Batt 
√Frames remaining sufficient 

Exp Comp (      ) – 0.0 
Exp Mode – P 
Meter – Matrix (     ) 
Diopter – Adjust 
Frame Rate – S 

√BKT disabled – 0 F 
Rear LCD: 
√ISO – 100 
√QUAL – RAW 
√WB – 0,A 

AF Area Mode – [ [  ] ] 
√Focus Area – Center 
√Focus Selector Lock – L 

 
SB-800 Flash Settings: 
√Diffuser Dome installed 

ON/OFF pb – ON 
√MODE –                      
√Exp Comp – 0 EV 

Tilt – 45° (Direct) 
 

Technique 
 1. Fill FOV w/sunlit subject 
 2. Activate D2Xs Camr 
 3. Auto Exp Lock – Depress,hold 
  Expect values such as 250,f/11 
 4. Focus, Frame, Fire 

Lens – 17-35mm @ 17mm 
Aperture – Min, locked 
Body Focus Mode – S 

√Batt installed 
√Flash Card installed 

Pwr – ON 
Top LCD: 
√Batt 
√Frames remaining sufficient 

Exp Comp (      ) – 0.0 
Exp Mode – A: 

f/stop – f/8 
Meter – Matrix (     ) 
Diopter – Adjust 
Frame Rate – Selftimer 

√BKT disabled – 0 F 
Rear LCD: 
√ISO – 100 
√QUAL – RAW 
√WB – 0,A 

AF Area Mode – [ [  ] ] 
√Focus Area – Center 
√Focus Selector Lock – L 

 
SB-800 Flash Settings: 
√Diffuser Dome installed 

ON/OFF pb – ON 
√MODE –                      
√Exp Comp – 0 EV 

Tilt – 45° (Direct) 
 

Accessory Equipment: 
Shutter Release Cable – Install 
Multiuse Brkt – Install 
Multiuse Brkt Clamp – Install as reqd 

 
Technique 

 1. Focus on crewmember 
 2. Body Focus Mode – M 
 3. Frame, Fire 

 
 

TTL BL TTL BL
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A7 
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1
ITVC-VIDEO
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2
ITVC-VIDEO
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3
LDRI-2D
VIDEO

4
2D +GAMMA

5
3D +FLICKER
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TOP 
 

HOOK 
VELCRO 

DIGITAL PLAYBACK

HD DIGITAL VIA CC DIGITAL VIA VTR 
NOTE  

Digital Playback from CC only possible for CC Video recordings 

ACTIVATION ACTIVATION

CC Setup per diagram (back of cue card) 
For cable strain relief, attach MPC-to-G1 Cable 
Velcro strap to CC strap 

 
AVIU SYNC/VIDEO – VIDEO 

HI-Z/75 – 75 
PWR SELECT – LO 

 
O19 √TV PWR – ON 
 
CC PWR dial – VCR/PLAY 
 
If Dnlk 
 Notify MCC, configuring for HD TV dnlk 
 
L10 (MUX) √MUX/VTR/CC PWR – on (LED on) 

√MUX BYPASS – ACT 
√CH 0,1 RATE SEL – 1 

  √2 RATE SEL – 8 
L10 (VTR) ON/STANDBY pb – push (LED red) 
L10 (VIP) PWR – off (LED off) 
 
O19 DC UTIL PWR MNA – ON 
MPC PWR SPLY DC PWR SPLY PWR SW1 – ON 
MPC PWR – ON (5V,3V green LEDs on) 
 
L10 (MUX) √CH 2 F/O OK LED on 
 

Setup per diagram (back of cue card) 
L10 (MUX) √VTR/CC PWR – on (LED on) 
L10 (VTR) √ON/STANDBY LED – green 

OPERATIONS 

PLBK or DNLK VIDEO 

L10 (VTR) Install tape if reqd 
 √DISPLAY SELECT – DATA 
 

If Index Search reqd: 
Remote   √ID – VTR4 

SEARCH MODE pb – push (INDEX 
SEARCH mode displayed) 

|  (  | ) pb – push to move highlight 
bar to desired GMT start 

When VTR auto-cue complete, green • 
displayed: 
PAUSE pb – push 

If playback time not displayed on DSR-25 LCD 
cycle “DATA CODE” repeatedly until time 
displayed 

L10 (VTR) REW(FF),PLAY,PAUSE pb – push as reqd to 
cue tape 

 
If Dnlk 
L10 (MUX) MUX/VTR/CC PWR – on (LED on) 

√MUX BYPASS – ACT 
√CH 3 DATA LED – on 

 
 
L10 (VTR) PLAY pb – push (green • displayed) 
 

If PLBK(DNLK) complete: 
STOP pb – push 

If VTR ops complete, go to DEACTIVATION 

OPERATIONS 
PLBK or DNLK VIDEO 

CC Install tape, if reqd 
 VTR pb – REW(FF),PLAY,PAUSE to cue tape 
 
If Dnlk 
MPC √HDV, TAXI LEDs – on 
L10 (MUX) √CH 2 DATA LED – on 
 
CC PLAY pb – push (green  displayed) 
 

If PLBK(DNLK) complete: 
STOP pb – push 

If CC ops complete, go to DEACTIVATION 
 
DEACTIVATION DEACTIVATION 

CC Remove, mark, stow tape as reqd 
PWR dial – OFF 

O19 TV PWR – OFF, as reqd 
 
If Dnlk 
MPC PWR – OFF 
MPC PWR SPLY DC PWR SPLY PWR SW1 – OFF 
O19 DC UTL PWR MNA – OFF 
L10 (MUX) √VTR/CC PWR – on (LED on) 
 MUX/VTR/CC PWR – off (LED off) 
L10 (VIP) PWR – on (LED on, DATA FLOW LED flashes 

twice) 
L10 (VTR) ON/STANDBY pb – push (LED green) 
 

Notify MCC, returned to SD TV dnlk 
 

Go to DEACTIVATION (Cue Card, TV), as reqd 
 

L10 (VTR) Remove, mark, stow tape as reqd 
Go to DEACTIVATION (Cue Card, TV) as reqd 

 

P/TV-13a/128/O/C
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TOP 
BACK OF ‘DIGITAL PLAYBACK’ 

HOOK 
VELCRO 

 

HD DIGITAL VIA CC PLAYBACK 

 

DIGITAL VIA VTR PLAYBACK 
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Pwr

FD CC
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J4

J6

J1

J5

J3
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MUXVTR/CC MUX/VTR/CC
ACT

MUX
BYPASS

IEEE 1394
Channel 3

RATE
SEL

TX RX
Channel 2

VIDEO
LO

75

Digital CC
Vid/Pwr
Cable

jsc48038_128_012e.cvx

FD CC

HDV/DV
N/A

ETHERNET

HDV

DATA OUT 16VDC IN

MPC

P2P1

J2

J1

J2

MPC DC Pwr
Cable (10 ft)P2/P2

MPC DC Pwr
Sply Cable (6 ft)

8

MPC-DTV MUX Cable
(ST-to-ST OPTICAL Cable)

MPC-G1 Cable
(DTV IEEE 1394 4-Pin to

Male Circ Cable (5 ft))

MPC-G1 Cable
(DTV IEEE 1394 4-Pin to
Female Circ Cable (5 ft))

P1

UNBAL
J4

MUX

VTR

ATU

VTR/CC MUX/VTR/CC
ACT

MUX
BYPASS

IEEE 1394
Channel 3

VIP REC

BAL
J3

J3

AUDIO IN/OUT

VTR
MONITOR

VIP OUT

VTR IN

VTR OUT

CCTV
VIDEO IN
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NOTE 
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NOTE 
Replace this page with four (4) sheets of blue 
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